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SECURITY REPORTER EVALUATION GUIDE PRODUCT OVERVIEW

SECURITY REPORTER EVALUATION GUIDE

Product Overview

The Security Reporter (SR) from M86 Security consists of the best in breed of M86
Professional Edition reporting software consolidated into one application, with the
capability to generate productivity reports of end user Internet activity from M86
Web Filter and/or M86 Secure Web Gateway (SWG) appliance(s), and security
reports from SWG policy servers.

Logs of end user Internet activity from Web Filters and/or SWGs are fed into SR,
giving you an overall picture of end user productivity in a bar chart dashboard, and
the ability to interrogate massive datasets through flexible drill-down technology,
until the desired view is obtained. This “view” can be memorized and saved to a
user-defined report menu for repetitive, scheduled execution and distribution.

Web Filter logs provide content for dynamic, real time graphical snapshots of
network Internet traffic. Drilling down into the URL categories or bandwidth gauges
dashboard quickly identifies the source of user-generated Web threats. SWG logs
provide content for bar charts detecting security threats on the network so that
prompt action can be taken to terminate them before they become a liability on
your network.

Using the SR, threats to your network are readily targeted, thus arming you with
the capability to take immediate action to halt the source, secure your network, and
protect your organization against lost productivity, network bandwidth issues, and
possible legal problems that can result from the misuse of Internet and intranet
resources.

Note to Evaluators

Thank you for taking the time to review the M86 Security Reporter (SR) appliance.
Your interest in our company and product is greatly appreciated.

This Evaluation Guide Is designed to provide product evaluators an efficient way to
install, configure and exercise the main product reporting features of the Security
Reporter: Productivity Reports, Real Time Reports, and Security Reports.

M86 SecuriTy EvAaLuATION GUIDE 5



SECURITY REPORTER EVALUATION GUIDE  INSTALL, CONFIGURE, AND TEST THE SECURITY REPORTER

Install

%

, Configure, and Test the Security Reporter

To install the SR appliance, configure the server, and test the unit to ensure that
reporting is operational, please refer to the step-by-step instructions in the M86
Security Reporter Appliance Installation Guide provided inside the carton
containing the chassis, or the Security Reporter Virtual Installation Guide down-
loaded from our public Web site at http://www.m86security.com/support/sr/docu-
mentation.asp .

Please note that prior to reviewing the SR, the M86 Web Filter and/or M86 Secure
Web Gateway (SWG) appliance(s) must already be installed. Either of these appli-
ances are required for this software release in order to send logs to the SR.

NOTE: See the M86 Web Filter Installation Guide or M86 WFR Installation Guide for infor-
mation on setting up the Web Filter on your network. See the M86 SWG Setup and
Configuration Guide for information on setting up the Secure Webh Gateway on your
network.

About this Evaluation Guide

The M86 Security Reporter Evaluation Guide is divided into three sections to cover
each of the basic reporting types:

» Section 1: Productivity Reports
e Section 2: Real Time Reports

» Section 3: Security Reports

M86 SecuriTy EvAaLuaTioN GUIDE
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SECTION 1: PRODUCTIVITY REPORTS UNDERSTAND THE MOST COMMON AND USEFUL FEATURES

SECTION 1: PRODUCTIVITY REPORTS

Understand the most common and useful features

This section of the Evaluation Guide leads the evaluator through the most common
and useful features of the Security Reporter, starting with the elements that should
be configured first, then moving on to the usage of the many different types of
reports available in the SR. You are directed through the normal path of initial
setup, and then led through a standard use case that explains how to investigate a
violation of your Internet Acceptable Use Palicy.

After stepping through this section of the Evaluation Guide, you will understand
how to set up powerful reports that can be e-mailed on a regular basis, thus mini-
mizing the effort required for ongoing configuration of the product. In short, by
pursuing these exercises, you will discover that the Security Reporter is both easy
to use while at the same time best in class in the level of detailed reporting it
provides.

@ TIP: After the SR appliance is installed, allow the Security Reporter to run for several days
prior to evaluating reports in order to optimize the evaluation experience. This will allow
the SR to accumulate multiple days of data and present more meaningful reports. Having
performed these preliminary steps, the SR will function properly on day one of the install
with some reports showing no data (e.g. “canned” Summary Reports).

M86 SecuriTy EvAaLuATION GUIDE 7



SECTION 1: PRODUCTIVITY REPORTS USE CUSTOM CATEGORY GROUPS TO NARROW YOUR SEARCH

Use Custom Category Groups to narrow your search

Prior to running any reports, there are a few recommended configuration steps that
create a more customized experience for the evaluator. The first step is to create
Custom Category Groups, which are customized groupings from the M86 Security
library of more than 100 filter categories. For example, most customers prefer to
set up a category group for those categories that are not allowed under their orga-
nization’'s Acceptable Use Policy. Creating such a category group reduces the time
it takes to identify violations of this policy.

To create, edit, or delete a Custom Category Group, navigate to Administration >
Custom Category Groups to display the Custom Category Groups panel:

Reports | Gauges | Policy | Administration | Help | Logout Security Reporter M

Custom Category Groups

Custom Category Group Custom Category Group Detail

This sereen allows the creation and edit of * Category Group Name Service Type (s UAL Baridwidth
Custom Category Groups. - -
Member Categories

Custom Category Group Aysiable Categorics Assigned Categories

Adware

nnnnnnnnnnnnnnnnn

News

Custom Category Groups panel
The Custom Category Groups panel is comprised of two sub-panels used for

setting up and maintaining category groups: Custom Category Group, and Custom
Category Group Detail.

How to add a Custom Category Group

1. At the bottom of the Custom Category Group sub-panel, click New.

2. In the Custom Category Group Detail sub-panel, type in the Category Group
Name.

3. Specify the Service Type to use: “URL” or “Bandwidth”.
4. Include the following Member Categories based on the Service Type selection:

* URL - Select Available Categories from the list and click Add to move the
selection(s) to the Assigned Categories list box.

» Bandwidth - In the Port Number field, type in a specific value in the pre-popu-
lated field, and/or use the up/down arrow buttons to increment/decrement the
current value by one, and then click Add Port to move the selection to the
Assigned Ports list box.

8 M86 SecuriTy EvAaLuaTioN GUIDE



SECTION 1: PRODUCTIVITY REPORTS USE CUSTOM USER GROUPS TO NARROW YOUR SEARCH

NOTE: At least one library category/protocol/port must be selected when creating a
gauge.

5. Click Save to save your settings and to include the name of the group you
added in the Custom Category Group list.

Use custom User Groups to narrow your search

The next step is to create User Groups, which are customized groupings of users
that reside on the organization’s network. For example, most enterprise customers
prefer to set up user groups for each department within the company, and educa-
tion customers prefer to set up separate user groups for each classroom or grade
level. Creating these user groups reduces the time it takes to identify the source of
violations of your organization’s Acceptable Use Policy.

How to create User Groups

To create, edit, or delete a user group, navigate to Administration > User Groups
to display the User Groups panel:

Reports | Gauges | Poliey | Administration |  Help Logout Security Reporter M

User Groups

User Groups Group Members

groups. Groups 2ssigned to you
n delegate fo other administrators, |

Parent aroups are precaded by an asterisk [°).
Status  Group Name Last Rebuilt

« All (System)

*10.130.0.0 (Custom)

*10.430.0.1 Custom)

*10.130.0.11 (Cuszom)

*10.130.0.12 (Custom)

*10.130.0.18 (Custom)

*10.130.0.2 (Custom)

*10.130.0.20 (Cuszom)

*10.130.0.4 (Custom)

*10.130.0.6 (Custom}

* ABC-SunONEW] lane.edu

* ABC-SunONEDirectory &

* ABC-SunONE\groups_dj

* ABC-SunONIE\Groups_bl

* ABC-SunONE\Groups_Dy

* ABC-SunONE\Groups_ja

* ABC-SunONE\Groups_ja

* ABC-SunONE\Groups_Qi

* ABC-SunONE\QCGroup_

* ABG-SUnONEVQCGroup_

Rebuild All Refresh | |

User Groups panel

The User Groups panel is comprised of two sub-panels used for setting up and
maintaining user groupings: User Groups, and Group Members.

1. From the User Groups list, select an existing user group to be used as the base
group for creating the new user group.

2. Click New to display the New User Group panel:
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SECTION 1: PRODUCTIVITY REPORTS  USE CUSTOM USER GROUPS TO NARROW YOUR SEARCH

Reports | Gauges | Poliey | Administration |  Help Logout Security Reporter M

New User Group || Patterns | | IPRanges | | Single Users (Exclude Group Name: Cancel

New User Group panel
3. Enter at least three characters for the Group Name to be used for the new user
group.

4. Click the checkbox(es) at the top of the panel to activate the pertinent corre-
sponding sub-panel(s) below: Patterns, IP Ranges, Single Users/Exclude.

5. After making entries in the pertinent sub-panels—as described in the following
sub-sections—click Save to save your edits.

Patterns sub-panel

The Patterns sub-panel is used for adding one or more patterns in order to narrow
the list of users to be included in the new group. A pattern consists of a wildcard, or
a wildcard plus one or more alphanumeric characters.

1. To add a pattern to the new user group, do one of the following:

» To add a pattern included in the base group, select the pattern from the
Parent Patterns box to display that pattern in the field below.

» To add a new pattern, enter the pattern in the field beneath the Parent
Patterns box. For example: Enter 200.10.100.3% to include all IP addresses
with ”200.10.100.3" as part of the IP address.

2. Click Add Pattern to include the pattern in the Assigned Patterns list box below.

@ TIP: Follow steps 1 and 2 above to include additional patterns for the new user group.
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SECTION 1: PRODUCTIVITY REPORTS USE CUSTOM USER GROUPS TO NARROW YOUR SEARCH

IP Ranges sub-panel

The IP Ranges sub-panel is used for specifying IP ranges to be used by the new
group.

Reports | Gauges | Poliey | Administration |  Help Logout Security Reporter M )

New User Group || Patterns |v| IP Ranges | | Single Users /Exclude Group Name: | studerts e SAVE Cancel

1P Ranges

Please assign at least one IP range. Use ‘Calculate [P Rangs®
below to calculate the startinglending IP address

Parent Ranges:
Starting IP Ending IP

0.0.0.0 255.265.265.255

Starting IP: Ending 1P:
182.0.0.0 192.255.255 255
Add 1P Range

|¥| Calculate IP Range

1P Address: Subnet Mask:

192.168.0.0 255.0.0.0
Caloulate IP Range

Assigned Ranges:

Starting IP Ending IP

Add user group, IP Ranges sub-panel

1. To add an IP address range, do one of the following:

» To make a selection from Parent Ranges, click the row in the Parent Ranges
box to highlight and select that row, and also to add that Starting IP and
Ending IP range in the Starting IP and Ending IP fields below. If necessary,
edits can be made to these fields.

» To add an IP address range without selecting from the Parent Ranges sub-
panel:

a. Enter the Starting IP address.
b. Enter the Ending IP address.
» To calculate an IP address range:

a. Click the Calculate IP Range checkbox to activate the IP Address and
Subnet Mask fields below.

b. Enter the IP Address.
c. Enter the Netmask which activates the Calculate Range button.

d. Click Calculate IP Range to display the Starting IP and Ending IP in the
fields above.

2. Click Add IP Range to include that IP range in the Assigned Ranges list box.
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12

Single Users/Exclude sub-panel

The Single Users/Exclude sub-panel is used for adding one or more users to the
group.

NOTES: Only users previously selected from the base user group will be included in the
Available Users list. A user name preceded by an asterisk ( * ) indicates an auto-assigned
user that can only be removed by adjusting the pattern or IP range for that user’s group.

Reports | Gauges | Poliey | Administration |  Help Logout Security Reporter M

New User Group Patterns | | IP Ranges |v/| Single Users i Exclude Group Name: Cancel
single Users / Exclude

Filters work against Username only. *%' = wildeard, *_* = single
character, and 'V = escaped character.

Available Users Filter:
Apply
Available Users:
User Name
192.168.20.79
192.168.200.100
192.168.200.102
192.168.200.107

192.168.200.11

R oot | Exclude

User Name

192.168.20.79
192.168.20.78
192.168.20.75
192168.20.74
192.168.20.72
192.168.20.71
192.168.20.152
192.168.20.225
192.168.20.220
192.168.20.218

192.168.20.212

[-1Remove

Add user group, Single Users sub-panel

To add users to the Assigned Users list, make your selections from the Available
Users list. If the Available Users list is long, you can reduce the number of results
that display in this list by using the Available Users Filter.

To use the Available Users Filter:

1. Enter filter terms to narrow the selection of Available Users. For example: Type
in 150% to only display results matching an IP address that begins with “150”.

2. Click Apply to display filtered results in the Available Users box.
To make selections from the Available Users box:
1. Select one or more IPs from the list to highlight the record(s).

2. Click [+] Add to include the selected user(s) in the Add tab.

How to Rebuild a User Group

A user group should be rebuilt if it is edited.
1. To rebuild a user group, select the user group to be rebuilt.
2. Click Rebuild to initiate the rebuild process for that user group.

3. After a few minutes, click the Refresh button to refresh the display in the panel.
Note that the Last Rebuilt column for user group you rebuilt now displays the
date and time of the rebuild.
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Use Security Reporter to conduct an investigation

Once Custom Category Groups and User Groups have been created, administra-
tors can begin running their first reports. In most cases, administrators will employ
the Security Reporter as a forensic tool to determine if anomalous Internet
behavior exists in their organization. In order to facilitate this process, the Security
Reporter menu structure is organized to follow the normal process flow of an inves-
tigation.

1. First, the administrator is greeted by productivity report content in “Summary
Reports.”

Additional information can be viewed by navigating to Reports > Dashboard
where high-level productivity report information shows data for Blocked
Requests and bar graph charts for Top Categories by Requests, Top Security
Risks by Requests, Top Blocked Users by Requests, and Top Users by
Requests. At a glance, the administrator can see if there is any anomalous
behavior that needs investigation.

By viewing either of these types of reports, a specific username might be iden-
tified as receiving a large number of blocked requests. Or a high rate of traffic
might be identified in the “PornographyAdult Content” category. If something is
detected that warrants further investigation, one would then proceed to the
“Drill Down Reports” section.

2. The next stage of the investigation, Drill Down Reports, lets the administrator
probe the multi-dimensional database to target the source of any Internet threat.

For example, if there is unusually high page count in the “Pornography/Adult
Content” category, the administrator can drill down into the Category/User
section to determine who is viewing this material. Once a specific end user is
identified, the administrator can then delve into the detail page view section to
see the exact pages that end user has been visiting.

This detailed information provides a wealth of information on the exact time the
page was visited, the user’s IP address, whether the site was blocked by the
Web Filter or SWG, how it was blocked (e.g. in URL library, blocked keyword,
proxy pattern blocking, etc), and the full-length URL. By viewing this detail, the
administrator can obtain an accurate gauge of the user’s intent—whether the
user repeatedly attempted to go to a forbidden site or whether it was an isolated
incident.

3. The last stage of an investigation is to document the long-term activity of a
policy violator, since most organizations require more than one or two events to
reprimand a user. Once the administrator determines the name of the user and
the Web sites visited in the Drill Down Report, the next step is to run a custom
report. The administrator can run a specific search of the policy violator for a
custom time period by selecting the “Report Wizard” option. When generating
this type of report, a custom time scope, specific category, and name of a
specific end user can be specified.

As an example, the administrator would probably run a custom report for the

policy violator by specifying the category “Pornography/Adult Content” and all
activity within that category within the last month. The administrator can then

save a PDF version of the report for documentation purposes. This custom
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report provides the necessary forensic information to support any internal repri-
mand and to protect the organization in the event the incident goes to court.

To summarize, the aforementioned steps were provided to give the user a most-
likely use case for the Security Reporter. The next sub-section provides a more in-
depth view of how to navigate within each of the main productivity reporting areas
of the Security Reporter: Summary Reports, Drill Down Reports, and Custom
Reports.

Use Summary Reports for a high level overview

As previously mentioned, Summary Reports provide an administrator an at-a-
glance view of any anomalous behavior that warrants an investigation. These
“canned reports” contain pre-generated data for a specified period of time
(Yesterday, Last Week, Last Month, Week to Yesterday, or Month to Yesterday) for
any of the following report topics or entities showing Internet activity:

Top 20 Users by Blocked Requests - Bar chart report depicting each top end
user’s total Page Count for Blocked and Warn Blocked requests. If using a Web
Filter only, this report is available if the Block Request Count feature is enabled
in the Optional Features screen in the System Configuration administrator
console.

Top 20 Users by Bandwidth Consumption (for SWG only) - Bar chart
depicting each top end user’s total Mega Bytes for bandwidth requests.

Top 20 Users by Virus Hit Count (for SWG only) - Bar chart report depicting
each top end user’s total Virus Count detected by the anti-virus engine.

Top 20 Categories by Page Count - Bar chart report depicting the total Page
Count in the top requested filtering library categories.

Top 20 Users by Page Count - Bar chart report depicting each top end user’s
total Page Count.

Top 20 Viruses Detected (for SWG only) - Bar chart report depicting the top
viruses and Virus Count detected by the anti-virus engine.

Top 20 Users by Malware by Hit Count - Bar chart report depicting each top
end user’s total “Blocked” and “Permitted” Hit Count from the following catego-
ries in the Security, Internet Productivity, and Internet Communication (Instant
Messaging) category groups: BotNet, Malicious Code/Virus, Bad Reputation
Domains, Spyware, Adware, and IRC.

NOTE: For SWG users, results that display in the Top 20 Users by Malware report reflect
library contents mapped to the M86 Supplied Categories.

Top 20 Sites by Page Count - Bar chart report depicting the total Page Count
for the most popular sites accessed by end users.

Top 20 User Groups by Page Count - Bar chart report depicting the total Page
Count for the top scoring user groups.

Top 20 Blocked Searched Keywords - Bar chart report depicting the total top
blocked keyword requests. For Web Filter users, this report is only available if
the Block Searched Keywords Report feature is enabled in the Optional
Features screen in the System Configuration administrator console.
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» Total Permitted vs. Blocked Requests - Pie chart report depicting the total
Page Count for all filtering categories Permitted to pass and all filtering catego-
ries set up to be Blocked.

» Category Group Comparison - Pie chart report depicting the total Page Count
in each top scoring filtering category group.

» Category Comparison - Pie chart report depicting the total Page Count in each
top scoring filtering category.

» User Group Comparison - Pie chart report depicting the total Page Count in
each top scoring user group.

Once you have obtained an overview of Internet activity using Summary Reports,
you can drill down to access more detailed information about specified end user
activity.

How to generate a Summary Report

1. To generate a Summary Report, go to the navigation panel and click Reports >
Summary Reports to display yesterday’s report view showing the Top 20
Users by Blocked Requests:

Reports | Gauges | Policy | Administration Help | Logout Security Reporter M

Summary Reports Yesterday Top 20 Users by Blocked Requests

Date Scope: | || Yesterday | [I] LastWeek | [if] LastMonth | [[ Week to Yesterday | [:] Month to Yesterday

4 Top20Usersby  Top20Usersby  Top20 Categories  Top
b Blocked Virus Hit Count by Page Count Pag
3 Requests

20Usersby  Top 20 Viruses Top20Usersby  Top20 Sites by Top 20 User Top20Blocked 5
je Count Detected Walware Hit Page Count Groups by Page Searched 4
Count Count Keywords 4

1381 Canna.Arerbery | |
=~

NIZ6\Bobby. Shelby
M86\Delbert Scriven

MBEMaric.May

.|
MBsieve wocd |

———————

I

M86\Quinton.

86 Betsy S
M86\Constance o

MBE\Lizabeth. Walton

MgB\Debra.irving

|
L
—
Mas\Alejandro Henson | |
I
pr—
—
=
J

M36iRobbin Downer

I
WssiGena Padmore | [
=

ME6\Lori Hoare
M86\Sean Traver

-
wggElvin.Bernard | [N
o

100,000 200,000 300,000 400,000 500,000
Blocked Request Count

Dovmioad Report: [ Ji_| POF B | C5V @ | PNS

Yesterday’s Top 20 Users by Blocked Requests Report

NOTES: On a newly installed SR unit, the panel will not show any thumbnail images or bar
chart report. If there was no activity for a given report type, the message “No Data to
display.” displays in the panel.

TIPS: Click the left arrows or right arrows at the edges of the dashboard to display thumb-
nail images that are currently hidden. Mouse over each bar in the bar graph to view the
name of graph entry and number of requests for that entry.

2. Click a Date Scope tab corresponding to the time period to be included in the
report: “Yesterday”, “Last Week”, “Last Month”, “Week to Yesterday”, or “Month
to Yesterday”.
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. Click one of the report type thumbnails beneath the Date Scope to display that

report view.

. To see details for the generated Summary Report view, at the bottom of the

report view, click a Download Report option for PDF, CSV, or PNG to generate
a report in the specified file format (.pdf, .csv, or .png):

Security Reporter Feb 28, 2011 - Feb 28, 2011 MBS
fEecUBITY

Report Type: Categories
Details: Top 20 Categories by Page Count. Chart based on Page Count

Top 20 Categories by Page Count

Search Engines
Information Technology

Online Greeting Cards
Gambling

Online Auction
Games

0 2,500 5,000 7,500 10,000 12,500 15,000 17,500
Page Count

3/1/2011 11:08:45 AM, Pacific Standard Time Generated by: administrator Page 10of3

Sample Bar Chart Summary Report in the PDF format

Security Reporter Feb 23, 2011 - Feb 23, 2011 MS.S
SEC 2] Y

Report Type: Category Groups
Details: Category Groups Cemparison.Page Count Comparison.

Category Group Comparison

- .
Internet 6% Internet Productivity, 5%

Shopping, 4%
Intemet/Intranet Misc_, 3%
Business/Investments, 3%
Entertainment, 2%

__~— Bandwidth, 1%
\\ Travel/Events, 1%
Adult Content, 1%
9 Others Combined, 2%

., 25%

Custom Categories, 46%

2/24/2011 4:45:26 PM, Pacific Standard Time Generated by: administrator Page 10of 3

Sample Pie Chart Summary Report in the PDF format

The header of the generated report includes the date range, Report Type, and
Details criteria.
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The footer of the report includes the date and time the report was generated
(using the M/D/YYYY, H:M:S AM/PM format), time zone, administrator login ID
(Generated by), and Page number and page range.

The body of the first page of the report includes the following information:

» Bar chart - Name of category, username, username path, URL or site IP
address, user group name, or blocked user request, and corresponding bar
graph. Beneath the bar graph are count indicators and a label describing the
type of Count used in the report.

» Pie chart - Color-coded pie graph showing a maximum of 15 categories or
user groups. Any categories or user groups with page counts totalling less
than one percent are grouped together under the “Others Combined” label.

The body of the pages following the first page of the bar or pie chart report
includes the following information:

» Top 20 Users by Blocked Requests report - User NAME and corresponding
BLOCKED REQUEST COUNT—which includes Blocked and Warn Blocked
requests. Total Records and Total Number of Blocked Requests for this Date
Scope display at the end of the report.

» Top 20 Blocked Searched Keywords report - Blocked Keywords and corre-
sponding Blocked Count. A Grand Total of Blocked Count displays at the end
of the report.

 All other reports - Count columns and corresponding totals for all reports.
Grand Total and Count display at the end of the report.

How to export a Summary Report

From the open PDF file, the Summary Report can be exported in some of the
following ways:

» Print the report - Click the print icon to open the Print dialog box, and proceed
with standard print procedures.

e Save the report - Navigate to File > Save (Page) As... to open the Save As
dialog box, and proceed with standard save procedures.
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Use Drill Down Reports for an investigation

In the event that Summary Reports in the Security Reporter dashboard reveal
abnormal activity, the next step in the investigation would be to drill down into the
particular category or user information.

This section provides information about “drill down” reports that let you query the
database to access more detailed information about end user Internet activity. The
following types of reports can be generated:

Categories - Includes data in each filter category that was set up for monitoring
user activity.

IPs - Includes Internet activity by user IP address.

Users - Includes Internet activity by username.

Sites - Includes activity on Web sites users accessed.
Category Groups - Includes activity by Category Groups.

User Groups - Includes activity by User Groups.

Once you have generated a drill down report view, you can customize your view,
save the view, export the view, and/or schedule the report to run at a designated
time.

How to generate a Summary Drill Down Report

1. To generate a summary Drill Down Report, go to the navigation panel and click

Reports > Drill Down Reports, and choose the report type to be generated.
The first menu selection is “Categories”; making this selection displays today’s
Categories report view by Page Count:

Reports | Gauges | Policy | Administration | Help Logout Security Reporter M

Drill Down Reports Categories
ReportType: | Categories | IPs | Users | Sites | CategoryGroups | UserGroups

Categories | Display: Top 50 by Page Count | Date: 08/17/2011 | Filter: Hone | Sort by: Page Count, Descending

7,000
£,000
5,000
4,000
3,000

2,000

I
) B

INSTMS Search Engines BannerfWeb Ads Information Technelogy Web Based Email Chat

Categories IP Count User Count Site Count Page Count Object Count Time HH:MM:SS

v
INSTMS 6818

11:42:10

N
R
o
&

5:45:0

o
2

\
\
T

211:20

1:39:50

B
=
E

1:56:10

B
& |
ol
%
]

1:30:40

8
B
3
5
-
B
5

0:48:10

o
13
[
i
&

0:34:30

£

0:18:20

0:48:20

H
5 I
&
2

Report Settings Iy Export All Gotopage |1 |5 of 1 total pages

Sample Drill Down Categories Report (summary report)

For each report type, by default the top portion of the report view includes tabs
for all productivity Report Types (Categories, IPs, Users, Sites, Category
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Groups, and User Groups). The following information displays beneath this row
of tabs: report type, Display criteria, Date, Filter criteria, and Sort by criteria.
Beneath this row, a bar chart depicts the first six records for the current report

type.

NOTE: Mousing over a bar in the chart displays the name of the record along with the total
count used in that record.

Beneath the bar chart is a table containing rows of records. Columns of perti-
nent statistics display for each record.

3. Use the tools at the bottom portion of the report view panel to modify the current

report view, creating the desired drill down view.

NOTE: See ‘Summary Drill Down Report navigation’ for information on using the reporting
elements described in this sub-section.

4. The drill down view can be exported, saved, and/or scheduled to run at a spec-

ified time.

Summary Drill Down Report navigation

Continuing from the last section, this section is designed to help the administrator
learn how to navigate within the Summary Drill Down Report. The Drill Down report
is unique in terms of the seemingly endless ways data can be displayed, but it is
important to understand all of the functions within this tool in order to generate
meaningful reports.

Count columns and links

In a summary drill down report view, Count columns (Category Count, IP Count,
User Count, Site Count, Page Count, Object Count) display after the column
containing the record name. Clicking a specific link in a record’s Count column
gives more in-depth analysis on a given record displayed in the current view.

Category Count - Displays the number of categories a user has visited, or the
number of categories included within a given site. It is possible for a site to be
listed in more than one category, so even if a user has visited only one site, this
column may count the user’s visit in two or three categories.

IP Count - Displays the number of sites or categories visited by the IP address
for a user’s machine.

User Count - Displays the number of individuals who have visited a specific site
or category.

Site Count - Displays the number of sites a user has visited, or the number of
sites in a category. This figure is based on the root name of the site. For
example, if a user visits www.espn.com, www.msn.com, and www.fox-
sports.com, that user will have visited three pages. If that same user additionally
visits www.espn.com/scores, the total number of sites visited would still count
as three—and not as four—because the latter page is on the original ESPN site
that was already counted.

Page Count - Displays the total number of pages visited. A user may visit only
one site, but visit 20 pages on that site. If a user visits a page with pop-up ads,
these items would add to the page count. If a page has banner ads that link to
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other pages, these items also would factor into the page count. In categories
that use a lot of pop-up ads—porn, gambling, and other related sites—the page
count usually exceeds the number of objects per page.

By clicking the link in this column, the detail report view displays data for all
pages accessed, including hyperlinks to those pages. In the detail report view,
you have the option to exclude Information columns for Date, Category, User IP,
User name, Site, Filter Action, Content Type, Content criteria, Search String,
and URL by de-selecting the corresponding checkboxes via the Column Visi-
bility option.

Object Count - Displays the number of objects on a Web page. All images,
graphics, multimedia items, and text items count as objects. The number of
objects on a page is generally higher than the number of pages a user visits.

However, if an advertisement or banner ad (an object on the page) is actually a
page from another site, this item would not be classified as an object but as a
page, since it comes from a different server.

By clicking the link in this column, the detail report view displays data for all
objects accessed, including hyperlinks to those objects. In the detail report view,
you have the option to include Information columns for Date, Category, User IP,
User name, Site, Filter Action, Content Type, Content criteria, Search String,
and URL by de-selecting the corresponding checkboxes via the Column Visi-
bility option.

NOTE: If “Pages only” was specified in the Log Import Settings sub-panel of the Optional
Features screen in the System Configuration user interface, all records of objects
accessed by end users will be lost for the time period in which this option was enabled.
Even if there were objects accessed by end users during that time period, zeroes (“0”) will
display in the Object Count column in the report. See the Optional Features sub-section of
the System Configuration Section for information about Log Import Settings sub-panel
options.

Bandwidth and Time columns

In a summary drill down report view, the Bandwidth and Time columns provide
additional information about a record.

Bandwidth - Displays the amount of bandwidth in GB or MB used for each
record, if using an SWG only with this SR.

NOTE: The Bandwidth column does not display if a Web Filter is used with this SR—with
or without an SWG.

Time HH:MM:SS - Displays the amount of time a user spent at a given site.
Each page detected by a user’s machine adds to the count. If a browser window
is opened to a certain page and left there for an extended time period, and that
page is refreshed by either the user or a banner ad, the counter starts again and
continues as long as Web activity is detected. If that Web page contains an
active banner ad that refreshes the page every 10 to 30 seconds, a user could
show an incredibly high page count and many minutes, even though only one
page was opened by that user.
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Column sorting tips

To sort summary report view records in ascending/descending order by a specified
column, click that column’s header: Category Count, IP Count, User Count, Site
Count, Bandwidth (for SWG), Page Count, Object Count, or Time HH:MM:SS.

Click the same column header again to sort records for that column in the reverse
order.

Click another column header to sort records by that specified column.

Record exportation

In a summary drill down report view, all records are selected for exportation by
default. Clicking Export All opens the Export pop-up window in which you specify
criteria for the report to be generated and distributed.

To select only specific records to export, click the first column of selected record
rows in the table, and then click Export Selected to open the Export pop-up
window.

Navigation tips

Report view breadcrumb trail links

When generating a report view and modifying that report view to create another
report view, a trail of breadcrumb links remain in the row beneath the navigation
toolbar. Clicking a link returns you to that prior report view.

Page navigation

At the bottom right of the panel, the Go to page field displays:

Go to page |1 : of 2 total pages

If more than one page of records displays for the total pages returned, enter a page
number within that range to navigate to that page of records, or use the up/down
arrow(s) to specify the page you want displayed.

21
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How to generate a Detail Drill Down Report

By using the Summary Drill Down Report, the administrator should have narrowed
the investigation to a specific category (e.g. “Pornography/Adult Content”) and a
specific user name. The next step is to drill down into the detailed URL information
to confirm the exact pages visited by the suspected policy violator.

To generate a detail drill down report, select the record and click the link in the
“Page Count” column of the Summary Drill Down Report:

Drill Down Reports

Date

Reports | Gauges | Policy | Administration |

A Category | UserIP

87/2011 12:0... Web Base... 142.117.174.59
8/17/2011 12:0... Web Base... 142.124.185.31
8/7/2041 12:0.. Web Base.. 14283.188.97
8772011 12:0.. Veb Base.. 142.117.27.93
8/7/2011 12:0... Web Base... 142.127.133.54
817/2011 12:0... WebBase... 142.183.123.32
8M7/2041 12:0.. WebBase.. 14218018248
81772011 12:0.. \eb Base.. 142.122.218.85
8A7/2011 12:0... Veb Base... 142.180.197.91
8/17/2011 12:0... Web Base... 142.127.135.79
8M7/2041 12:0.. WebBase.. 142117.169.70
8772011 12:0.. Web Base... 142.127.135.79
817/2011 12:0... Web Base... 142.127.135.79
8/17/2011 12:0... Web Base... 172.26.144.117
8M7/2041 12:0.. WebBase.. 142113.416.70
8772011 12:0.. WebBase.. 142.117.159.70
87/2011 12:0... Web Base... 142.122.66.24
8/17/2011 12:0... Web Base... 142.127.133.54
8M7/2041 12:0.. Web Base.. 172.26.150.72
8772011 12:0.. WebBase.. 142.117.159.70
87/2011 12:0... Web Base... 142.117.159.70

8/17/2011 12:0... Web Base.. 1421228468

Report Settings

Web Based Email

Help | Logout

Page Detail

Report Type: | Categories | IPs

Categories

User

testDomainiUse..

testDomainiUse..

testDomainlUse.
testDomainlUse.

testDomain!

testDomainiUse..

testDomainUse.

Display: All records

Site

.. getemail.sympa..

. google.com

google.com

. google.com

testDomainiUse... yahoo.

testDomain!

testDomainiUse..

testDomainlUse.
testDomainlUse.

testD:

. 142.182.19.28

google.com

142.182.19.28

Security Reporter ,M )

Users | Sites | CategoryGroups | User Groups

Date: 08/17/2011 | Filter: HiA | Sortby: Date, Ascending

Filter Action |Content.. Content S.. |URL

Allowed URL t i

Allowed URL hitp:fimail.googl hittp:!mail.geoql

Allowed URL hitp://mail google com/

Allowed URL hitp:/imail google com/

Allowed URL hitp://mail.googl hitp:/'mail.geoql

Allowed URL hitp:fimail.googl hittp:!mail.geoql

Allowed URL hittp: /by 04fd bay104 hittp://by1 04fd bay104 hotmail msn comicai
Allowed Wildeard http:/* MAIL yahoo.co hittp/1520 mil yahoo comymiiogin? rand=
Allowed URL hitp://mail.googl hittp://mail.geoql

Allowed URL htp: 1.googh hitps //142.182.18.28

Allowed URL hitp://mail.google com/ hitp://mailgoogle.

Allowed URL https:iimail google co. https /142 182 15 28

Allowed URL hitps:iimail.google.co. hitps:1/142.162.19.28

Allowed Wildeard hitp:11*. MAIL.yah: http:/Imail.yah

Allowed URL hitp://mail google com/

Allowed URL http:/imail.google.com/

Allowed URL hitp://mail.googl

Allowed URL hitp://mail.googl

Allowed URL hitp://mail google com/

Allowed URL http:/imail.google.com/

Allowed URL hitp://mail.googl hitp://mail.qooal

Allowed URL hitp:/mail.googl http:/Imail.aoogl

Export All Column Visibility_|| Gotopage |1

IEJ of 2 total pages

Detail Drill Down Report view

Detail Drill Down Report navigation

Report type columns

In the detail report view, by default all Page/Object Detail column(s) display. Any of
these columns can be hidden from view by clicking the Column Visibility button at
the bottom of the panel to open the Column Visibility pop-up window, and de-
selecting the checkbox corresponding to that column:

Column Visibility

x !

™
4]
4
4
™
4]
4

[

Date
Category
UserIP

User

Site

Filter Acticn
Content Type

Content

Cancel

Column Visibility window

» Date - Displays the date in the M/D/YYYY H:M:S AM/PM format
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» Category - Displays the category name (e.g. “Alcohol”).
» User IP - Displays the IP address of the user’s machine (e.g. “200.10.101.80").

» User - Displays any of the following information: username, user IP address, or
the path and username (e.g. “logo\admin\jsmith”).

» Site - Displays the URL the user attempted to access (e.g. “coors.com”).

» Filter Action - Displays the type of filter action used by the Web Filter in
creating the record: "Allowed", "Blocked", "Warn Blocked" (for the first warning
page that displayed for the end user), "Warn Allowed" (for any subsequent
warning page that displayed for the end user), “Quota Blocked” (if a quota
blocked the end user), "X-Strike", or "N/A" if the filter action was unclassified at
the time the log file was created.

» Content Type - Displays the method used by the Web Filter in creating the
record: “Search KW” (Search Engine Keyword), “URL KW” (URL Keyword),
“URL", “Wildcard”, “Https High” (HTTPS Filtering Level set at High), “X-strike” (X
Strikes Blocking), “Pattern” (Proxy Pattern Blocking), “File Type”, “Https
Medium” (HTTPS Filtering Level set at Medium), or “N/A” if the content was
unclassified at the time the log file was created.

» Content - Displays criteria used for determining the categorization of the
record, or “N/A” if unclassified.

» Search String - Displays the full search string the end user typed into a search
engine text box in search sites such as Google, Bing, Yahoo!, MSN, AOL,
Ask.com, YouTube.com, and MySpace.com—if the Search Engine Reporting
option is enabled in the Optional Features screen of the System Configuration
administrator console user interface.

* URL - Displays the link for the page/object accessed by the end user.

Detail Drill Down Report exercise

For the purpose of this evaluation, follow these steps to witness how the Security
Reporter is best in class in terms of the extent of detailed page and object informa-
tion it provides.

Step A: Select a specific user by Category

If not already completed, click the “Page Count” column link for any record in the
Summary Drill Down Report.

Step B: Sort by “Filter Action” column

Clicking the “Filter Action” column header will sort all records by the type of filter
action—whether the event was blocked, allowed or warned. Blocked searches will
be highlighted in red font for easier detection.

Step C: Full URL review

The full length URL of every Internet search by the users is listed in the “URL”
column of the detail page information.

To view record data that displays truncated in a column, mouse over the column to
view the entire string of data in the column for a given record:
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Search 5t... URL

hetps/ v, .org/includes/jquery.dropdownPlainjs

hitpethananw . bower....

Mouse over to view full URL

Click the URL link to launch the actual Web site viewed by the user to verify the
content that was accessed.

Step D: Sort by “Content Type”

Sort by the column labeled “Content Type” by clicking that column header. This will
sort all records by the search type filtered on the Web Filter or SWG. For example,
“URL"” indicates a page request was blocked or allowed based on the status of that
URL in the Web Filter category library and “Search KW” indicates a user typed in
a prohibited word into a search engine text box. One of M86 Security’s differentia-
tors is “Proxy Pattern Blocking,” which will show up in the “Content Type” section
if an Internet proxy site was blocked by M86 Security’s proprietary proxy signature
detection.

After reviewing a suspected policy violator’s Internet activity in the Detail Drill
Down Report, the administrator will have firm evidence on the user’s intent, which
is critical forensic information to have in the event the investigation moves to the
disciplinary phase.

Step E: Sort by “Search String”

Sort by the column labeled “Search String” by clicking that column header. This will
sort all records alphabetically for results that include search string information.
Search string content includes the actual text typed into a search engine text box
on popular search engine sites such as Google, Bing, Yahoo!, YouTube, Ask.com,
and MSN. For example, if the end user typed in “recipes for chicken breast” in a
search engine request, that entire string will appear in this column, not simply the
blocked keywords within the request. This depth of detail helps clarify the intent of
the end user, which helps tremendously in investigations.

In the next section, this guide will go through the final step in a typical investiga-
tion—creating a custom report for a specific user via the productivity Report
Wizard.
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Create a custom report for a specific user

After reviewing the detail drill down report, if the administrator is confident that an
individual has violated the Internet Acceptable Use Policy (AUP), the most
common step to take next is to run a custom report for this specific individual that
covers a greater time period period. While there are several ways to accomplish
this in the Security Reporter, this guide will focus on the most commonly used
method—the productivity Report Wizard.

How to use the Report Wizard for a single user report

The Report Wizard option provides an intuitive setup process for generating
custom reports for one time use, or for recurrence at scheduled time periods. The
productivity “Report Wizard” option is available by navigating to Reports > Drill
Down Reports > Report Wizard:

Reports | Gauges | Policy | Administration | Help | Logout Security Reporter M
Drill Down Report Wizard Summary Report
Drill Down Report Wizard

What kind of custom report do you want to create? (@) Summary Report {By Hit Count and Time) () Detail Report

Filters (optional):
Note: You cannot select both Category Group and User Group.

| B Catagory

| p.ByuseriF.

| BBy Usemame:

|.b By Site:

|.b By Category Group:

|2 By User Group.

Report Wizard panel for summary reports

Step A: Create either a Summary Report or a Detail Report

Select one of two available custom productivity report options:

 Summary Report (By Hit Count and Time) - This report provides a synopsis

of specified end user Internet activity by hit count and time for a designated
period.

» Detail Report - This report provides information about end user Web page or
Web object access for a specified time period.
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Reports | Gauges | Policy | Administration | Help Logout Security Reporter M
Drill Down Report Wizard Detail Report
Drill Down Report Wizard
What kind of custom report do you want to create? () Summary Report (By Hit Count and Time) (@) Detail Report

Specify at least one of the following filters:

) Specific User Detail by Page. () Speifi User Detal by Object Mote: You cannot sslect both Category Group an User Group

| By Category: |

Date Scope: | Today v
— e ———m (Hone)
213_test2
213Catt
= 23test
Sortby: | Date v i
= Alcohol
Order: | Ascending - |
Ndnniiniaii: SER— RS AliCov
Limit Detail Result (@) Show both blocked and non-blocked records el
) Show blocked records only Approved Content
Ant
V| Showtop 1000 records
Bad Reputation Domains
Bannerfilleb Ads
Blocked Exception
| b By User IP:
| b By Username:
| b By Site

| b By User Group:

|
|
|
|.b By Category Group: |
|
.8y Keyworei |

Report Wizard panel for detail reports

Step B: Specify the Report Type

Summary report

Make a choice for the Type of report to be generated; for this exercise, choose
“Categories” or “Sites”.

In this exercise, narrow your results for the specified user by choosing the Filters
(optional) accordion for “By User IP” or “By Username”, as described in Step C.

Detail report

1. Choose the type of detail report to use in the query:

» Specific User Detail by Page - Includes viewed page results
» Specific User Detail by Object - Includes viewed object results

2. Specify at least one of the following filters in the accordions at right to
narrow your search—for this exercise, “By User IP” or “By Username”—as
described in Step C.

Step C: Specify Filters

For this exercise, choose either of these filters:

* By User IP - If selecting this filter, enter the end user IP address for filtering your
results—using the ‘%’ wildcard to return multiple IP addresses—and then click
Search to display query results in the list box below.

* By Username - If selecting this filter, enter the end username to filter your
results—using the ‘%’ wildcard to return multiple usernames—and then click
Search to display query results in the list box below.
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For a detail report, select the username and click the right arrow ( >) to move
the username into the Added Usernames list box.

Step D: Specify Other Report Components

Specify criteria for the remaining components to be used in the report:
» Date Scope - Choose the date scope to be included in the results.

NOTE: For detail reports, if more than one username or if any keyword is entered in this
panel, the following Date Scope choices are the only choices available: “Yesterday”
(default), “Previous 7 Days”, selections for Previous 6, 5, 4, 3, or 2 Days, and “Daily”.

* Number of Records - For a summary report, specify the number of records to
be returned in the results.

e Sort by - Select column by which the results will be sorted and displayed in the
report.

* Order - For a detail report, indicate whether results will be sorted in “Ascending”
or “Descending” order.

» Limit Detail Result - For a detail report, specify the number of records to be
returned in the results, and if these records will only include records of blocked
end user queries, or also records of non-blocked end user queries.

Step E: Specify when to Generate the Report

Indicate the next step in the wizard by selecting one of two choices that specify
when the report will be generated:

* Run - Click this button to generate and view the drill down report now in the
specified report view format.

» Save - Click this button to go to the Save Report panel where you save your
report criteria now but generate your report later.
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Step F: Save the Report

1.

Click the Save button to display the Basic Options tab of the Drill Down
Reports > Report Wizard > Save Report panel:

Reports | Gauges | Policy | Administration | Help

Drill Down Report Wizard Summary Report

Save Report

Basic Options ‘Advanced Options

Report Info Email

Save Name: To:

Description: ce:

Subject:
Body:

Output Type:

Format:

Logout

[] Hide unidentified 1Ps
| Email As Atachment | v |

| PoE - |

Filters

Category:

UserIp:

Users:

Site:
Category Group:
User Group:

Keywords:

(__save and schedule |(_save ana Eman_|(_saveony |

Security Reporter M

WA

WA

WA

WA

WA

WA

Drill Down Report Wizard’'s Save Report panel Basic Options tab

the Reports > Saved Reports list box.

. In the Save Name field, enter a name for the report. This name will display in

@ TIP: The Copy (Ctrl+C) and Paste (Ctrl+V) functions can be used in the fields in this
screen.

3. In the Description field, enter the report description.
4.

Specify Email criteria:

» To and Subject, and optional fields for Body, Cc, and Bcc.

» Hide Unidentified IPs checkbox is de-selected by default if the “Hide
Unidentified IPs” checkbox is de-selected in the Default Report Settings

panel.

» QOutput Type - Choose either “Email As Attachment”, or “Email As Link”.

* Format - Choose from available output format selections in the pull-down

menu.

NOTE: Any selected filter options display to the right.

5. Click the Advanced Options tab for additional options:

» Group By - Available selections are based on the type of report specified.

» For summary reports, at the For multi-level Group By reports only field, if
a selection was made in the Group By field, specify the top count option to be

used in the Number of Records and Sort By fields.

» For a summary report, For pie and bar charts only, the activated Generate
Using field lets you select the count column sort option.

» For detail reports, specify any of the following options:
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» Detailed Info - Uncheck any checkbox corresponding to a column that
should not be included in the report.

* Limit Detail Result - Indicate the maximum number of records to be
included in the report, and whether these records will only include blocked
end user queries, or also records of non-blocked end user queries.

6. Specify the next—or final—step in the wizard by selecting one of three choices:

» Save and Schedule - Click this button to save your entries and to go to the
Schedule Report panel where you set up a schedule for running the report:

Reports | Gauges | Policy | Administration |  Help Logout Security Reporter M
Drill Down Report Wizard Summary Report
Schedule Report
() MNOTE: I you would like your scheduled event to run today, be sure
t 1o Specify 2 future Start Time for today
Name
Report to Run:  categories
When to Run: | Daily -
Start Time

e = Elam v

Cancal

Drill Down Report Wizard’s Schedule Report panel

a. Enter a Name for the Report to Run.

b. Select the frequency When to Run from the pull-down menu (Daily,
Weekly, or Monthly).

If Weekly, specify the Day of the Week from the pull-down menu (Sunday
- Saturday).
If Monthly, specify the Day of the Month from the pull-down menu (1 -
31).

c. Select the Start Time for the report: 1 - 12 for the hour, 0 - 59 for the
minutes, and AM or PM.

NOTE: The default Start Time is 8:00 AM. If you wish to run a report today and this time
has already passed, be sure to select a future time.

d. Click Save to save your report schedule settings and to go to the Report
Schedule panel where the report is now included in the list.

TIP: Click Cancel to save the report and to return to the Report Wizard panel without
scheduling a time for running the report.

e Save and Email - Click this button to save your entries and to email the
generated report to the designated recipient(s). After the report is emailed,
the Saved Reports panel displays if you need to run this report again or
another report.
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Reports | Gauges Policy | Administration ‘ Help ‘Logout Security Reporter M

Saved Reports

Reports

Please select a report to editidelete/duplicate

_Run_|[_Duplicate | [_Delete | (=it

Saved Reports panel

» Save Only - Click this button to save your entries and to go to the Saved
Reports panel where you can delete, edit, or run this report or another report.
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Export Summary Drill Down Reports

For this exercise, you will learn how to export a customized Summary Drill Down
Report.

How to export selected records

Step A: Select records to be exported

To only include specific records in the summary drill down report, click the first
column of each row containing the selected record while simultaneously

depressing the Ctrl key in the keyboard.

Step B: Specify Data to Export

1. Click the Export Selected button to open the Export pop-up box:

Export x

GroupBy: | Categories v

Format: | POF v
Datato Export: | Al the rows on this report v |
For multi-level Group By reports only

Number of Records:

Sort By:

For pie and bar charts only
Generate Using:

For email output only

To:
Ge
Bog:
Subject:

Body:

Ema\\. Duwnlnaé Cancel
Summary drill down Export pop-up box

2. At the Data to Export field pull-down menu, specify the amount of data to be
exported. For this exercise, choose “Only selected rows on this page”.

Step C: Export data via Email or PDF Download option

1. Make selections and/or entries in all fields in the Export pop-up box.

2. Click the Email or Download button to close this pop-up box and to export the
data—via email or to your workstation—in the specified file format.

Email option

The email option for exporting reports lets you electronically send the report in the
specified file format to designated personnel.
& WARNING: If using a spam filter on your mail server, email messages or attachments

might not be delivered if these messages contain keywords that are set up to be blocked.
Consult with the administrator of the mail server for work around solutions between the

spam filter and mail server.

31
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1. In the Export pop-up box, enter the following information:

» To field - Type in the email address of each intended report recipient, sepa-
rating each address by a comma (,) and a space.

» Subject field (optional) - Type in a brief description about the report.

» Cc field (optional) - Type in the email address of each intended recipient of a
carbon copy of this message, separating each address by a comma (,) and a
space.

» Bcc field (optional) - Type in the email address of each intended recipient of
a blind carbon copy of this message, separating each address by a comma (,)
and a space.

» Body field (optional) - Type in text pertaining to the report.
2. Click Email to send the report to the designated recipient(s).

& WARNING: Large reports might not be sent due to email size restrictions on your mail
server. The maximum size of an email message is often two or three MB. Please consult
your mail server administrator for more information about email size restrictions.

View and print options

The view and print options for exporting reports let you view/print the report in the
specified file format. The view option lets you make any necessary adjustments to
your report file settings prior to printing the report. To print the report, you must
have a printer configured for your workstation.

In the Export pop-up box, click the Download button to generate and download the
report in the specified file format.

NOTE: Reports generated in the format for MS-DOS Text, Comma-Delimited Text, or
Excel (Chinese or English) will display a single row of text for each record. Reports gener-
ated in all other formats (PDF, Rich Text Format, HTML) will display any lengthy string of
text wrapped around below.
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Sample report file formats

%

The following report file formats are available for emailing and viewing: “MS-DOS
Text”, “PDF”, “Rich Text Format”, “HTML", “Comma-Delimited Text”, “Excel
(Chinese)”, “Excel (English)”.

NOTES: M86 Security recommends using the PDF and HTML file formats over other file
format selections—in particular for detail reports—since these files display and print in a
format that is easiest to read. Lengthy text in PDF, HTML, and Rich Text Format files
wraps around within the column so all text is captured without displaying truncated.

Comma-Delimited Text and Excel report columns may display with truncated text, but an
entire column can be viewed by mani-pulating the column width in the generated report
file. These reports can then be printed at a smaller percentage than normal size in order to
accommodate all text.

For MS-DOS Text reports, text may display truncated—in parti-cular for lengthy usernames
and URLs in detail reports—but an entire column can be viewed by scrolling to the right.
Since there is no way to manipulate text in the generated report file, the printed report may
display with truncated text. However, the maximum amount of text can be captured by
printing the report in the landscape format.

PDF

This is a sample of the Category Groups report in the PDF format, saved with a
.pdf file extension:

Security Reporter Oct 20, 2011 - Oct 20, 2011 MNE5

Category Groups
Teg 50 Category Groups by Page Count sorted by Page Count, descending

Dtpeet Time HR U
G Consd 0 b 5 Const
13 LRTE) =
4 » ] 0za0 148
n " 0430 Iy
n " s 030 156
7 7 050 19

s

3
3

| o
,._.,_N.Eg
HE§
zE;E
H §

cecEaraddenEly

| cccnwmnon
5| -

| ===

B = =m=

B

V202011 B:31:27 AM, Pacific Daylight Time Generated by: wizard Filter: None. Page 10l 1

Category Groups report, PDF format

Examples of other report formats are provided in the M86 Security Reporter User
Guide.
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Summary Drill Down Reporting tools

The Security Reporter has a variety of different reporting options. In a fashion
similar to the specific user report creation process, administrators can also create
custom reports from any Drill Down Report view. These reports can be set up to be
automatically emailed to the administrator on a regular basis in a variety of formats
(e.g. PDF, Excel, etc.).

How to use other Summary Drill Down Report tools

Limit Detail Result

1. At the bottom left of the report view, hover over Report Settings and select
Limit Detail Result to open the Limit Detail Result pop-up box:

- B —
Limit Detail Result x

The quantity of records specified here affects the
maximum number of records that will display in
the generated detail report (both view and print).
Specifying "all records" or a large number of
records may cause slowness in loading reports.

() Show all records

(@) Showtop | 1000 records
Apply Cancel
Limit Detail Result pop-up box

2. Indicate the limit for the set of records to be returned by selecting the appro-
priate radio button:

» Show all records - Click this radio button to include all records returned by
the report query.

» Show top ‘X' records - Click this radio button to only include the specified top
set of records returned by the report query.

3. Indicate the number of records to be included in a set by making an entry in the
blank field, represented here by the ‘X'

4. Click Apply to apply your settings in the current report view and to close this
pop-up box.

Report fields

Type field

The Type field is used for specifying the report type for the summary report to be
generated.

At the Type field, make a selection from the pull-down menu for one of the avail-
able report types: “Categories”, “IPs”, “Users”, “Sites”, “Category Groups”, “User
Groups”, and the current report format displayed.
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Date Scope and Date fields

The Date Scope field is used for specifying the period of time to be included in the
generated report view. Depending on the scope selected, the From Date and To
Date fields are used in conjunction with this field.

At the Date Scope field, make a selection from the pull down menu for the time
sub-panel you wish to use in your query: “Today”, “Month to Date”, “Monthly",
“Year to Date", “Daily”, “Yesterday", “Month to Yesterday", “Year to Yesterday",
“Last Week", “Last Weekend", “Current Week", “Last Month”. Reports can be run
for any data saved in the SR’s memory.

» Today - This option generates the report view for today only, if logs from the
Web access logging device have been received and processed.

* Month to Date - This option generates the report view for the range of days that
includes the first day of the current month through today.

* Monthly - Selecting this option activates the from and to date fields where you
specify the date range using the calendar icons.

* Year to Date - This option generates the report view for the range of days that
includes the first day of the current year through today.

» Daily - Selecting this option activates the from and to date fields where you
specify the date range using the calendar icons. The generated report view
includes data for the specified days only, if the data for these days are stored on
the SR.

* Yesterday - This option generates the report view for yesterday only.

* Month to Yesterday - This option generates the report view for the range of
days that includes the first day of the current month through yesterday.

* Year to Yesterday - This option generates the report view for the range of days
that includes the first day of the current year through yesterday.

» Last Week - This option generates the report view for all days in the past week,
beginning with Sunday and ending with Saturday.

» Last Weekend - This option generates the report view for the past Saturday
and Sunday.

» Current Week - This option generates the report view for today and all previous
days in the current week, beginning with Sunday and ending with Saturday.

» Last Month - This option generates the report view for all days within the past
month.

Number of Records fields

The Number of Records fields are used for specifying the number of records from
the query you wish to include in the summary drill down report view, and how these
records will be sorted.

Inthe Number of Records field, indicate whether the report view should “Show all
records” or “Show top ‘X’ records”. If the latter selection is made, the value that
displays in this field may have come from the Default Report Settings panel and
can be modified.
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Filter and Filter String fields

The filter fields are used for narrowing results that display in the current summary
drill down report view.

At the Filter field, make a selection from the pull-down menu for the filter term to be
used: “None”, “Contains”, “Starts with”, “Ends with”.

The Filter String field displays greyed-out if “None” was selected at the Filter
field. If any other selection was made at that field, enter text in this field corre-
sponding to the type of filter term to be used.

Sort By and Limit summary result to fields

The sort fields are used for specifying the report view column by which the gener-
ated report will be sorted.

At the Sort By field, make a selection from the pull-down menu for one of the avail-
able sort options: “Name of ‘x™, “Category Count”, “IP Count”, “User Count”, “Site
Count”, “Page Count”, “Object Count”, “Time”, “Hit Count”, “Bandwidth”.

If the “Name of ‘X’ option is selected, the Limit summary result to field displays.
Make a selection from the pull-down menu for one of the available choices for
which the summary report results will be limited: “Top Category Count”, “Top IP
Count”, “Top User Count”, “Top Site Count”, “Top Page Count”, “Top Object
Count”, “Top Time”, “Top Hit Count”, “Top Bandwidth”.

Group By field

The Group By field is used for indicating the manner in which records will display
for the specified report view when exported.

Choose from the available report selections at the Group By pull-down menu.
Based on the current report view displayed, the selections in this menu might
include the main report type such as “Sites”, double-combination report types
such as “Users/Sites”, triple-combination report types such as “User/Category/
IPs”, or pie or bar charts.

Format field

The Format field is used for specifying the manner in which text from the report
view will be outputted.

At the Format pull-down menu, choose the format for the report: “MS-DOS Text”,
“PDF”, “Rich Text Format”, “HTML", “Comma-Delimited Text", “Excel (Chinese)”,
and “Excel (English)”.
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For multi-level Group By reports only

The Number of Records and Sort By fields are used when exporting multi-combi-
nation summary drill down reports and are deactivated by default.

Number of Records field

The Number of Records field is used for specifying the number of records that will
display for the selected sort option. By default, this field displays greyed-out and
becomes activated when a different Group By option is selected.

In the activated Number of Records field, indicate whether to “Show all records”
or “Show top ‘X’ records”.

Sort By field

The Sort By field is used for specifying the report view column by which the gener-
ated report will be sorted.

For summary drill down reports, at the Sort By field, make a selection from the
pull-down menu for one of the available sort options: “Category Count”, “IP
Count”, “User Count”, “Site Count”, “Page Count”, “Object Count”, “Time”, “Hit
Count”, “Bandwidth"—the latter option available in an SWG only environment.

For pie and bar charts only

Generate Using field

The Generate Using field is used when exporting a drill down Categories, Category
Group, or User Group pie chart or bar chart report, and determines by which
column the report will be sorted. By default, the field displays greyed-out and
becomes activated when a pie or bar chart report is selected from the Group By
pull-down menu.

At the activated Generate Using field, make a selection from the pull-down menu
for the sort option to be used: “Category Count”, IP Count”, “User Count”, “Site
Count”, “Page Count”, “Object Count”, “Time”, “Hit Count”, “Bandwidth"—the latter
option available in an SWG only environment.

Output Type field

The Output Type field is used for specifying how the generated report will be sent
to the recipient(s).

At the Output Type field, choose either “Email As Attachment”, or “Email As Link”.
Hide Unidentified IPs checkbox

The Hide Unidentified IPs checkbox is used for specifying whether or not IP
addresses of workstations that are not assigned to a designated end user will be
included in reports. This checkbox is deselected by default if the checkbox by this
same name was de-selected in the Default Report Settings panel.

To change the selection in this field, click the Hide Unidentified IPs checkbox to
remove—or add—a check mark in the checkbox. By entering a check mark in this
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checkbox, activity on machines not assigned to specific end users will not be
included in report views. Changing this selection will not affect the setting previ-
ously saved in the Default Report Settings panel.

Email / For email output only fields

Email fields are used for entering email criteria pertinent to the report to be sent to
the designated addressee(s).

Specify the following in the Email or For Email output only fields:

To - Enter the email address of each intended report recipient, separating each
address by a comma (,) and a space.

Subject - Type in a brief description about the report.

Cc (optional) - Enter the email address of each intended recipient of a carbon
copy of this message, separating each address by a comma (,) and a space.

Bcc (optional) - Enter the email address of each intended recipient of a blind
carbon copy of this message, separating each address by a comma (,) and a
space.

Body - Type in text pertaining to the report.
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Commonly used reports

Though this portion of the Evaluation Guide is primarily designed to lead the eval-
uator through the process of an investigation using common productivity reports,
there are many other useful features to explore in Security Reporter productivity
reports. Below is a summary of some of the other custom reports an administrator
can create and have automatically emailed on a regular basis in order to be kept
up to date on Internet threats arising from within the organization.

M86 Security has created 10 different sample report formats to help first time users
understand the various types of reports available in the Security Reporter. For
purposes of this Evaluation Guide, only three of the 10 are described in detail

below. A description of all other sample
User Guide.

reports is available in the Security Reporter

How to generate a Sample Report

1. From the Reports menu, choose Sample Reports:

feparts | Gauges Polcy | Admuniatraion () Logout

Sample Reports

M=

Secunty Reporter

Sample Reports

. Click one of the following thumbnails to open a separate browser window

containing the generated Sample Report in the PDF format:

Top 20 IPs by Category/IP
Top 20 Users by Category/User
Top 20 Users by Page Count

Top 20 Sites by User/Site

By User/Category/Site

Top 20 Sites by Category/Site
By Category/Site/IP

By Category/User/Site

M86 SecuriTy EvAaLuATION GUIDE

Top 20 Categories by Page Count

Top 20 Categories by User/Category
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3. From the open PDF file, the Sample Report can be printed or saved.

4. Click the “X” in the upper right corner of the report window to close it.

Report format

The report header contains the following information: “Security Reporter” and date
range for today’s date; report name; description for that report type, including the
sort order and Page Count, descending.

The body of the report contains rows of records and is comprised of one or more
sections.

For each record, end user statistics display in columns such as: Category Count,
IP Count, Site Count, Bandwidth (GB or MB amounts display for SWG only), Page
Count, Object Count, Time (HH:MM:SS), Hit Count, and Blocked Hits.

Total counts display at the end of each section.
The Grand Total and total Count for all sections display at the end of the report.

The footer on each page contains the following information: today’s date (M/D/
YYYY), time (HH:MM:SS AM/PM), and time zone in which the report was gener-
ated; Generated by: manager’s login ID; Filter: None; Page number and page
range.
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Examples of available Sample Reports

Sample Report 1: “Top 20 Users by Category/User”

This report shows the top 20 users for each of the categories in the M86 Security
library. This is a useful tool to quickly scan for excessive use of any category.

Security Reporter Oct 20, 2011 - Oct 20, 2011 MBE
Category/Users
All Categories sorted by Page Count, descending
Top 20 Users by Page Count in each Categories table

Category INSTMS
Users P Site Page Object Tirme Ht Blocked

Crumr Count Crnt Coues (RS Crurs tieg
tesiDemaunUseIssTS 1 13 " ] =31 “ ]
testDomainLisers5TH 1 13 N [ a0 7] ]
SDOMAMLISAHE5E 1 LE] " [ a0 u ]
testDomaniLserT 3417 1 13 ] ] (=31 " o
testDomamLiseria T 1 13 N [ a0 7] ]
eDemMALISeTE0S 1 3 u ] o210 u ]
eSDOMEMLSS08S 1 iE] " [ oz " ]
testDonmainilser27006 1 13 " ] 0210 14 ]
testDomainiLiser 14045 1 13 4 ] a0 14 ]
tesiDemunUseSee0 1 13 " ] =31 “ ]
testDomainLisers7 136 1 6 7 [ [3E ) 7 ]
DOMAMLISAG5 1 6 7 [ (%] 7 ]
SDOMAMLISAI2EET 1 6 7 [ (%] 7 ]
eSIDOMEMLSA 3953 1 6 T [ [AE] 7 ]
testDomainiliseT417 1 & T ] a1 7 o
testDemauMLse4 703 1 3 7 ] [ 7 ]
teStDemuMLUBerg4ST 1 3 4 ] 003 4 ]
testDomanLiseas15 1 3 N [ o030 4 ]
esDOmMAMLISe 0653 1 ] 4 [ o030 4 ]
SDOMEMUS 216 1 3 4 [ 030 4 ]
Total for INSTMES E ] 178 198 ] 0:20:40 180 ]
User Count: 20 soried by Page Count, descanding
Categery. Search Engines
usars ® N Fage Cjoct Tirne HE Blocked

Count Count Count Cours [HHMMES) Coues higa
1020/2011 11:17:34 AM, Pacific Daylight Time  Generated by: wizard Filter: Mone Page 1 of 19

Sample Category/Users report

Sample Report 2: “Top 20 Sites by User/Site”

This report will document the top 20 sites visited for every user in the organization.
This is a useful tool in monitoring the high level Web activity of users, and can help
fine-tune sites the administrator allows users to access.
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Security Reporter Oct 20, 2011 - Oct 20, 2011 MBE
User/Sites
All Users sorted by Page Count, descending
Top 20 Sites by Page Count in each Lisers table
User-testDomainLiserGa178
Sines Category P Page Cgect Time Hit Biocked
Lount. LCouunt. LCouund. Lount Ll MRS, Lount s
1421803173 1 1 2 o o1 2 o
(LFALx ol ) 1 1 1 o [ieR ] 1 o
142.180.188.33 1 1 1 ] 0010 1 o
1M19153 1 1 1 o oo 1 o
(LFAL-RELE, ) 1 1 1 o [ieR ] 1 o
42117 B4R 1 1 1 ] 0010 1 o
MLAE251.242 1 1 1 o oo 1 [
LT 168106 1 1 1 '] (e ] 1 [
161 16 141 146 1 1 1 o o0 1 ']
14211375130 1 1 1 o o1 1 o
1T2.28.224.38 1 1 1 o [ieR ] 1 o
142,182 3042 1 1 1 ] 0010 1 o
4212713054 1 1 1 ] 0010 1 o
Total for testDomainLiset 3178 13 13 " o o310 14 ']
ane Count: 13 soned by Page Count, descending
UsertestDomaniLiserB5060
Shes Category " Page Cpect T Hi Bocked
Sl Sl e T Lount Lo BN Lount bty
21803173 1 1 2 '] oo 2z [
1421680 188 33 1 1 1 o o0 1 ']
17215153 1 1 1 o o1 1 o
(LFAL-RELE, ) 1 1 1 o [ieR ] 1 o
42117 B4R 1 1 1 ] 0010 1 o
142,182 51.242 1 1 1 ] 0010 1 o
10072011 11:27:36 AM, Paafic Daylight Time: Generated by. wizard Filter: None: Page 1 0f 228

Sample User/Sites report

Sample Report 3: “By Category/User/Site”

This is an example of a triple break report that shows all activity on the network,
broken out by category, then user, and then site. This is a useful report if the
administrator is looking for an all-encompassing view of Internet activity within the
organization. However, please note that this is usually a very lengthy report since
it captures all user information by site.

Security Reporter Oct 20, 2011 - Oct 20, 2011 MBE
Category/User/Sites
All Categones sorted by Page Count, descending
All Sites in each Users lable
Category INSTMS
UsertestDomainiLiser 1196
Sites P Page Oiogect Time it Fioched
Lot Lount Lount (HHMMES] Lount. s
207481004 1 o 1 000 1 0
Total for SeRDomainiiser( 1 196 1 o 1 000 1 0
Site Count. 1 sorted by Page Count descending
Category INSTMS
UsertestDomainiUserd 1508
Sies P Page Cepect Time Ht Bioched
Lount. Lount. Count. (HHMMSE) Count. His,
24 com 1 o 1 o 1 a
Total for MesDomainiLser) 1909 1 o 1 000 1 0
Site Count. 1 sorted by Page Count descending
Category INSTMS
UsertestDomainiUserd3 105
Sies P Page Cepect Time Ht Bioched
Lo, Lount. Lount. VHH MM SS) Lount. s
am com 1 o 1 aga 1 a
Total for testDomainiLise03108 1 [] 1 ann 1 a
‘She Count: 1 scned by Page Counl, destending
Category INSTMS
1020/2011 11:30.09 AM, Pacific Daylight Time  Generated by. wizard Filter: None Page 1 of 300

Sample Category/User/Sites report
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SECTION 2: REAL TIME REPORTS

Real time reporting features are available if using a Web Filter with your Security

Reporter.

Understand the most common and useful features

In this section of the Evaluation Guide, you will learn how to read URL Dashboard
gauges that target areas on your network that could potentially endanger its secu-
rity and/or usurp most of its bandwidth, and how to identify users who are violating
your organization’s policies and prevent them from continuing to pursue such

activities.

Monitor URL gauges

When clicking Gauges in the navigation toolbar, the URL Dashboard displays:

URL Bandwidth

Shopping

Reports | Gauges | Policy | Adminisiration Help Logout

ecurity llegal Bandwidth Adult Content All Categories

Security Reporter M

URL dashboard with URL gauges

NOTE: The bandwidth gauges dashboard is displayed by clicking the Bandwidth button to
the right of the URL button above the dashboard. The bandwidth gauges dashboard

shows you end user activity for bandwidth protocols set up to be monitored by the Security
Reporter. More about bandwidth gauges is described later in this section of the Evaluation

Guide.

Each URL gauge represented in the Dashboard is comprised of library categories
and monitors a targeted user group’s access of URLs in a specified library cate-

gory.

M86 SecuriTy EvAaLuATION GUIDE
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How to drill down into a URL gauge

This exercise will step you through the manual monitoring of users in real time via
the URL gauges Dashboard. Note that this is simply one of many ways to use SR
to monitor insider threats. There is also a robust automated alert component that
does not require the system administrator to be monitoring gauges in order to be
notified of a violation in process.

Step A: How to read a URL gauge

The graphic and sub-sections below describe how to read gauges on the URL
gauges Dashboard:

Gauge Name

The gauge name is the customized Gauge Name
name of the gauge created by the
administrator. SR has five default
. Threat
sample gauges that correspond to five Atllmtiomem/ Level S AllProtocals

of M86’s super-categories: Shopping,
Security, lllegal, Bandwidth and Adult Gauge
Content. Administrators can create B~ 3"‘“5(:0,9""’ SOV
their own gauges as well as delete the Timaspan: 15hin. Timaspan: 134in.

default gauges. URL Gauge Bandwidth Gauge

¥ )

Gauge Score

The gauge score is the large number in the center of the gauge that is based upon
the number of URL page hits (see NOTE below) that occur in this specific category
in a given period of time.

NOTES: In addition to page hits, SR also counts “blocked object” hits. For reference,
“pages hits” are files that typically end in .html and represent a main page view. “Object
hits” are files that typically end in .gif or .jpg and represent image files.

To streamline your task, SR does not track a score for “non-blocked objects,” since these
gauges are designed to provide a clear picture of how many times a user has requested a
page, and objects are images hosted within a page. SR includes blocked object data to
cover instances in which harmful images are hosted on a non-harmful site.

Timespan

Each gauge monitors events in real time for a window of time between one and 60
minutes. This timespan is customizable by the administrator. For example, if a
gauge is set for 15 minutes, that gauge will indicate the number of page hits for the
last 15 minutes of time. For example, if the current time is 12:00, the gauge score
will reflect all activity from 11:45 to 12:00. Once the time is 12:01, the gauge will
reflect all activity from 11:46 to 12:01.
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Threat Level

The colored threat level indicates the current state of threat A et
based on the customizable ceiling created by the administrator. '
For example, if the administrator creates a gauge with a

threshold of 100, when the score reaches 67 the gauge dial will
move into the red threat level section, the score will turn red, and
a yellow warning triangle symbol will appear and begin to flash.

Timespan: 15hin.

These gauges are designed to provide an intuitive reminder when a specific cate-
gory gauge is experiencing abnormal levels of activity so the administrator can
react quickly.

Step B: Identify the source of a gauge’s activity

Each gauge is comprised of one or more gauge components—derived from library
categories in the Web Filter. Sometimes end user activity in a single component is
responsible for driving a gauge’s score.

To identify the source of a gauge’s activity, from the URL dashboard you can either
click the gauge or right-click the gauge and then select “View Gauge Ranking”:

Performing either of the two aforementioned actions on the gauge will open the
Gauge Ranking panel showing a list of all end users affecting this gauge’s compo-
nents, and all affected components in this gauge:

Reports | Gauges | Policy | Administration | Help | Logout Security Reporter M

Gauge Ranking: All Categories

Username Bandwidth Liability Others Productivity Security Total v
126
”
81
52

N
=]
=]
=

=

N

&

17
16

&
8
=
B
8
i
#
oo e oo e

R R
N R

e B e B

© o 5 e |

o
b
2

Results Per Page: 25 /v

Open the Gauge Ranking panel

If a single component is affecting the entire gauge, you can investigate activity in
that component by drilling down into the component with the highest score.
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Step C: View a list of Threats the end user accessed

In the Gauge Ranking panel, click the highest score in a column for a component;
this action displays the Category View User panel showing a list of All Categories
accessed by the selected end user for the gauge component:

Reports | Gauges | Policy \Aaminis|mﬁun|

Categories

Click on a category below to see its URL details.
Categories with zera scores will not yield any

results.

Categories Total
Bannerilleb Ads 55
Vieb Based Email 28
Image Servers & Image Search Engines 12
Free Hosts 4
Yanoo 1M 2

Back_

Help | Logout

Category View User: 192.168.30.92 - Gauge Name: All Categories

URLs
Links are provided for viewing content in a separate browser window.

URLS

Security Reporter

M

Timestamp

View a list of Threats accessed by the user for that gauge

Step D: View URLs visited by the end user

Click a library category to display a list of associated, categorized URLSs visited by

the end user:

Reports | Gauges | Policy | Administration

Categories

Click on a category below to see its URL details.

Categories with zero scores will not yield any
results
Categories Total
T
Wieb Based Email 28
Image Servers & Image Search Engines 12
Free Hosts 4
Yaheo IM 2

Back

Help Logout

Category View User: 192.168.30.92 - Gauge Name: All Categories

URLs
Links are provided for viewing content in a separate browser window.
URLS

http:iiads bluelithium comyifr:

Security Reporter

httpeiiad i E.

OAIA

httpsiiad — F.

oAlA

http:iiad

/imp? PVID=upQF2Hi8eviIVzobOTIghUwE

httpciiad

http:iiad om/imp? pQF21j o

httpeiiad /st? p

http:iiad /st? PVID-upGi

http:iiad omfimp? PVID=

http:iiad 1594627

B4630458 18:52=180

httpeiiad 159482 7

/BA4630458 18:52=180

http:iiad fimp? P

JOFrvRUVBIAEA

httpciiad

httpeiiad om/st? PVID=cZ5RWIG RNQVzobQTl

httpeiiad /st? o

http:iiad

httpoiiad omfimp? PVID=8eoliGH

http:/iad om/imp? PVID=8e20ltGH

fimp? PVID=8220ltGH

hitp:/i bt

fimp? PVID=8e20ltGH

RUyhiss5t

om/st? PVID=Be2oltG RigVzob

i oACzN

httpeiiad /st? P RlgVz0bG

i oACzN

M

Timestamp v
2010-08-23 10:18:17
2010-09-23 10:98:17
2010.09.23 10:18:17
2010-08-23 10:19:17
2010-08-23 10:18:17
20100923 10:18:17
2010.09:23 10:18:09
2010-08-23 10:19:08
2010-08-23 10:18:00
2010-09-23 10:18:00
2010-09:23 10:18:00
2010-08-23 10:18:00
2010-08-23 10:18:00
2010-09-23 10:18:00
2010-09:23 10:18:00
2010-08-23 10:18:00
2010-08-23 10:18:65
2010-09-23 10:18:55
2010.09:23 10:18:55
2010-09-23 10:18:55
2010-08-23 10:18:65
2010-09-23 10:18:55

2010-09.23 10:18:55

View URLs for the selected threat

Any URL in this list can be clicked to display the contents viewed by the end user.
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Step E: Further investigate a user’s activity

Now that you've identified the current trend of Internet activity on your network and
targeted key participants engaging in undesired Internet usage, you can further
investigate a specific end user’s activity and then take the appropriate steps for
disciplinary action.

To access Internet usage data for a single end user with a high score, return to the
Gauge Ranking table by clicking the greyish-white Back button at the bottom left of
the panel.

Click the Username link for that user to display the User Summary panel:

Reports | Gauges | Policy | Administration Help Logout Security Reporter M
User Summary I 192.168.30.92 iP: 192.168.30.92
User Detail Information

|V Graup Membership

All

@ Al Categories
@ legal
@ Adult Content

@ Shopping

e o o = e o™

| b Lockout score Total: 14

Back

View the user’s gauge activity in the User Summary panel
A list of groups to which the user belongs displays to the left, and a list of gauges
displays to the right, showing the user’s score for each gauge.

To drill down and view activity in any gauge the user affected, select the gauge,
and then click the Category View button at the bottom of the panel to display the
Category View User panel (the panel shown in steps C and D in this section).

NOTE: There is also a way to automatically lock out the user that will be demonstrated
later in this document.
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How to view URL Trend Reports

SR lets you generate historical trend reports that show activity by URL threats for
a specified time period. These trend reports are helpful for monitoring improvement
of activity in a certain library category as well as providing a good tool for setting
appropriate thresholds for each URL gauge.

Step A: View overall activity in URL gauges

Navigate to Reports > URL Trend Charts to display the URL Trend Charts panel:

Security Reporter M@ﬁ

URL Trend Charts

1Hour | 6Hours 12 Hours 1Day 1 Week 1 Month

1 Day

Shopping

Bandwidth

VAnaheim Ducks NHL

Adult Content = Bandwidth lllegal = Security = Shopping | All Categories = Anaheim Ducks NHL

URL Trend Charts panel

The pie trend chart is divided into pie slices named for each gauge in which there
was activity. The size of each slice is determined by the amount of activity in that
gauge for the designated time period, in comparison to activity in all other URL
gauges during that same time period. All activity is translated into a percentage
figure, with the total activity for all slices equaling 100 percent.

You can change the time span represented in the trend chart by clicking one of five
other tabs at the top of the chart. Choices range from the last hour to the last month
of data.
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Step B: View aline chart for a single URL gauge

To uncover more information about activity in a particular gauge, click the pie slice

for that gauge to view a line chart depicting that gauge’s activity within the specified
time period:

Reports | Gauges | Policy | Administration | Help Logaut Security Reporter M =
Bandwidth hits in 1 Day [ BackioPie

500 —
Adult Contant
Bandwidth

llegal
00 —

curity

Shopping

All Categories

Anaheim Ducks HHL
300 —

OODEDOC OER

Show All

I¥oos

200 —

100 —

10312010 123:00:00 10312010 17:00:00  10-312010 21:00:00  11-01-2010 01:00:00 11012010 05:00:00 11012010 08:00:00  11-01-2010 13:00:00
HOURS

View activity for a specified gauge

TIP: You can also go to the bottom of the pie chart and click a tab for a gauge to access
the line chart for that gauge within the specified time period.

The score and minutes in which activity occurred display, represented by a line
graph. The chart can be modified by clicking checkboxes to the right to include
lines in the chart depicting activity in other gauges.
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How to view a pie chart for a URL gauge

Now that you know how to access a pie trend chart showing overall gauge activity
and how to drill down to view a line chart for a specific gauge, you will next learn
how to access a pie chart for a specific gauge.

1. Gotothe URL gauges Dashboard and click the middle icon at the bottom of the
gauge:

Trend Charts

The gauge Trend Charts icon

2. The action of clicking the Trend Charts icon displays a pie Gauge Trend Chart
for that gauge:

 Reporis | Geuges | Poliy | Adminsisation | Help :[ jou — Security Reporter MBE
Gauge Trend Chart [ Back _

Bandwidth

Bandwidth | Liability = Others | Productivity | Security

Gauge Trend Chart

Note the pie slices in this trend chart are named for each gauge component in
which there was activity.

The time span represented in the trend chart can be changed by clicking one of
five other tabs at the top of the chart.

Click a pie slice or tab beneath the pie chart to drill down into that gauge compo-

nent and view a line chart showing that gauge component’s activity within the
specified time period.
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Monitor Bandwidth gauges

Once you've seen how URL gauges help you monitor end user Internet traffic, you
will probably want to explore the ways bandwidth gauges help you monitor inbound
and outbound bandwidth usage on your network.

How to view the Bandwidth gauges Dashboard

The bandwidth gauges Dashboard gives you an overview of current end user
bandwidth activity on your network. To display this panel, first select Gauges and
then click the Bandwidth tab above the Dashboard:

Reports | Gauges | Policy | Administration Help | Logout Security Reporter M (

SMTP

Bandwidth gauges Dashboard

Default bandwidth gauges include the following protocol gauges: FTP, HTTP, IM,
P2P and SMTP. Protocol gauges are comprised of ports. For example, the FTP
protocol includes ports 20 and 21.

Note the score in the middle of each gauge. This score shows the amount of band-
width traffic in bytes (kB, MB, GB).

As with URL gauges, from this panel you can drill down to view end user activity in
a bandwidth gauge and view trend charts on bandwidth gauge activity.
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How to drill down into a Bandwidth gauge

Looking at the bandwidth gauges Dashboard, you can see at a glance which band-

width gauge has the highest score. To identify the end users affecting that gauge,
you will need to drill down into that gauge.

Step A: View Bandwidth protocol traffic information

In the bandwidth gauges Dashboard, click a high-scoring gauge to display the
Gauge Ranking table showing all end user traffic for that protocol:

Reports | Gauges | Policy | Administration |  Help Logout

Security Reporter M |
Gauge Ranking: SMTP

username 110 25

3.00 kB

Back

Results Per Page: 25 v

View bandwidth used by each end user for the protocol

To the right of the Username column are port numbers that comprise the protocol.
The number of bytes of bandwidth used by each user displays in these columns.

Step B: View a user’s protocol usage information

To drill down and view a user’s bandwidth usage in all bandwidth gauge protocols,
click a Username to display the User Summary panel.

In the Gauge Readings sub-panel to the right side in this panel, click the Bandwidth
Gauges tab to display each bandwidth Gauge Name and its corresponding
Inbound, Outbound, and Total bytes of traffic used by that end user for that gauge:
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Reporis | Gauges | Policy | Administration Help. ‘ Logout Security Reporter
User Summary  Threat Assessment Level ser: 192.168.2077 I1P: 192.168.2077
User Detail Information Gauge Readings
| Group Membership " LRI  Bandwidth Gauges
i Gauge Hame Inbound Qutbound Total v
ety g @ e 2.00 kB 1.00 kB 4.00 kB
Maiiagars @ swre 1.00 kB 2.00 kB 3.00 kB
@ P 0.00 kB 0.00 kB 0.00 kB
' P2P 0.00 kB 0.00 kB 0.00 kB
' M 0.00 kB 0.00 kB 0.00 kB
| b Lockout Score Total: 7.00 kB
Back

User Summary panel showing the user’s bandwidth protocol usage

Step C: View a user’s port usage information

Now drill down and view a user’s port usage for a particular gauge. In the Gauge
Readings sub-panel, click the Gauge Name to activate the Category View button.
Click that button to display the Category View User panel:

Reports | Gauges Palicy | Administration ‘
Category View User: 192,168.20.77 - Gauge Name: HTTP

Categories

Ports

a3

Help | Logout

MEE

Security Reporter

Inbound Outbound | Total

2.00 kB 1.00 kB 4.00 kB

Back

Category View User panel showing the user’s port usage
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How to view Bandwidth Trend Chart activity

As you have seen with URL gauges, in addition to drilling down into a gauge to find
out which end users are driving that gauge’s activity, you can get an overall picture
of a bandwidth gauge’s current activity by generating a trend chart.

Step A: View overall activity in Bandwidth gauges

Navigate to Reports > Bandwidth Trend Charts to display the Bandwidth Trend
Charts panel:

Security Reporter M@a

(Ul GSHours | 42Hours | 4Day | 1Week | 1Month
Total Traffic1 Hour

FTP | HTTP | IM | P2P | SMTP

Bandwidth Trend Charts panel

The pie trend chart is divided into pie slices named for each bandwidth gauge in
which there was activity. The size of each slice is determined by the amount of
activity in that gauge for the designated time period, in comparison to activity in all
other bandwidth gauges during that same time period. All activity is translated into
a percentage figure, with the total activity for all slices equaling 100 percent.

You can change the time span represented in the trend chart by clicking one of five
other tabs at the top of the chart. Choices range from the last hour to the last month
of data.
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Step B: View a line chart for a single Bandwidth gauge

To learn more about the activity for a particular gauge, click the pie slice for that

gauge to view a line chart depicting that gauge’s activity within the specified time
period:

NOTE: The “score” on bandwidth gauges is based on the number bytes of bandwidth
consumed; not page hits, as with URL gauges.

Reports | Gauges | Policy | Administration | Help ‘ Logaut Security Reporter M ’

HTTP Bandwidth usage in 1 Hour |_BacktoPie

14—

g 34035

o —

| | I | | | I
11-01-2010 13:50:00 11-01-2010 14:00:00 11-01-2010 14:10:00 11-01-2010 14:20:00  11-01-2010 14:30:00 11-01-2010 14:40:00 11-01-2010 14:50.00
MINUTES

Line chart for a bandwidth gauge
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How to view charts for a specific Bandwidth gauge

In the bandwidth gauges Dashboard, click the Trend Charts icon in the bottom
middle of the gauge to display a pie trend chart for that gauge:

Gauge Jrand,Chark,je

SHours | 1Zfours | 10ay | 1Weck | 1Month

1 Hour

443 | 80 | 3080

curity Reporter

MEE

BECURITY

Bandwidth Gauge Trend Chart for a specified protocol (HTTP)

Click the pie slice or tab below to view a line chart showing traffic for that port:

80 Bandwidth usage in 1 Hour | Esciiofe |

14—

law) 3¥0s

~ Security Reporter

MEE

BECURITY

o
E I T 1 I
11012010 13:50:00 11012010 14:00:00 41012010 14:40:00  11-012010 14:20:00  14-01-2010 14:30:00
MINUTE S

11-01-2010 14:40:00 11-01-2010 12:50:00

n a3
E 80
m 2080
m Show All

Line chart for a specified port
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Get the complete picture

As you have seen so far, the real time reporting section of the SR user interface
lets you monitor URL and bandwidth gauge activity on your network. Analyzing
data from both sources will give you a complete picture of the user’s Internet usage
behavior.

How to view Overall Ranking of user activity

The first step in finding out which end users are most actively driving gauges is to
consult the Overall Ranking table that shows you a list of users affecting URL
gauges and Bandwidth gauges, all in one panel. This ranking table is accessed by
navigating to Gauges > Overall Ranking:

Reports | Gauges | Policy | Administration Help Logout Security Reporter M

Overall Ranking

Bandwidth

Username Score Username Inbound Outhound

192,168,200 201 2867 192 166.168.71 .50 WB 566 kB

192,168,200 45 1018 192 166.200.158 590 kB 178 kB

192.162.30.170 a8 192.182.200.21 E79 kB 20 kB
343 kB 71k

132 168 30177 so7 132 188411

192.168.30.33 221 192 166830 85 261 kB 16 kB

192,188 20,200 125 192 186.200.208 187 ke 102 ke

132.169.200.31 186 192.182.30.88 129 kB 51kB

132 168 41,1 104 132 18820 143 81kB 21kB

132.168.30.85 34 192 1663080 74 kB 16 kB

132.166.200.208 14 192 188.200.88 56 kB 22 kB

132.168.20.86 10 192.168.200.226 10k B8 kB

132 18830 54 56 kB 17k

132 168.200.95 19 kB 40 kB

192.182.200.131 32 kB 12 kB

a
&

132,168,200 26 7 192.182.200.90 48 kB kB
a
1

132 18844 13 36 kB TKE

192 1683087 14 kB 4 kB

192.188.20.170 1kB 18 kB

192.182.200.201 10k B LE

132 18820045 KB SKE

132 168.30.170 11k e

192 18830 177 kB BKE

192.182.30.28 ELE 1kE

132 18820204 BKE 1kE

192.168.20 213 5 kB 1kB

Overall Ranking table

Note the URL sub-panel to the left includes the Username and Score of each user
with activity in one or more URL gauges. The Bandwidth sub-panel to the right
includes the Username and number of bytes of Inbound and Outbound traffic used
by that end user in one or more bandwidth gauges. Users listed in each sub-panel
are ranked in order by their scores.

Clicking a Username link takes you to the User Summary panel where more details
about that end user’s activity can be viewed, and action can be taken to restrict or
prevent that end user’s Internet/network activities.

57

M86 SecuriTy EvAaLuATION GUIDE



SECTION 2: REAL TIME REPORTS GET THE COMPLETE PICTURE

How to create a New Gauge

After working with the URL and bandwidth gauges for awhile, you may want to

customize the default gauges or create your own to more effectively monitor the
type of traffic on your network.

Step A: Select Add/Edit Gauges

In order to create a new custom gauge, navigate to Gauges > Add/Edit Gauges
to display the panel by that name:

Reports | Gauges | Policy | Administration | Help Logout Security Reporter M )
Add/Edit Gauges
Bandwidih Gaea [ super category Group [] category ciass [T] Category Group
Gauge Hame Group Threshold Timespan (minutes) Gauge Components
@ snopping
@ Ssecuri ity
@ llegal 00 15
@ Bandwidth 00 15
@ A
@ Al Categories
|_New Gauge |
Select Add/Edit Gauges

By default the URL Gauges tab displays, showing the list of URL gauges in the
sub-panel to the left. If you wish to create a bandwidth gauge, click the Bandwidth
Gauges tab to display the list of bandwidth gauges in this sub-panel.

Note that only five bandwidth gauges can be used at a time. If you wish to create
a bandwidth gauge, an existing bandwidth gauge must first be deleted.

Step B: Add a New Gauge

Click the New Gauge button to display the URL Gauge or Bandwidth Gauge panel,
as appropriate to the selection made in the previous panel.

This is an example of the URL Gauge panel:
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Reports rnugn‘ Policy ‘mem| Help ‘ Logout == Security Reporter MBE
URL Gauge

Gauge Information

This screen allows you fo
create a new gauge or editan c c es. Only one group can be assigned or up to 15 categories.
existing gauge. -~ :

Available Categories/Groups n Assigned Categories/Groups
Gauge Hame:
Adult Content
Adware
Group Threshold: Alcohol i
200 = Ansheim Ducks NHL

Animals/Pets
Timespan (minutes):

i 10 20 30 40 50 60

Art

Bad Reputation Domains

Bandwidth

Bandwidth
Salige Method Banneriieb Ads
(@) an () Others () Patern

Blocked Exception
() search Engine Keyword
Books & LiteratureWritings

() URL Keyword () URL
o Botilet

(L) HTTPS Filtering - High () Wildcard

e
(L) HTTPS Filtering - Medium (_) X Strike G
Chat
Child Pornegraphy
cIPA

Comics

Lo M Rencwe
|bemr stz |
_save | [ Gancel |

Add a New URL Gauge

Step C: Specify Gauge Information

Set parameters for the custom gauge by making the following entries/selections in
the Gauge Information sub-panel at the left side of the panel:

Reports | Gauges | Policy | Admimisiration | MHelp | Logout Security Reporter MBE

URL Gauge

Gauge Information

This screen aliows you to
create a new gauge or editan rows reprasent Cateqory Groups/Classes, others represent Cateqories. Only one group can be assigned of Up to 15 categories
existing gauge

I super Category Group [l Category Cisss [l Category Group

Available CategoriesiGroups . Assigned Categories/Groups
Gauge Hame:
AL Adult Content
Adware
Group Threshold: Alcohol i
200 = Anzheim Ducks NHL

Animals/Pets
Timespan (minutes): =
t

1 10 20 30 40 50 60

Bad Reputation Domains

Bandwidth

Bandwidth
SoNap Methot: Banneriieb Ads
(@) Al oth ) Patt
L ) Others ) Paltem Blosked Exception
() Search Engine Keyword
Books & Literature/irtings
() URL Keyword (O uRL
Bottlet
() HTTPS Filtering - High () Wildcard
() HTTPS Filtering - Medium () XStrike Businesslinvestments

Chat
Child Pornography.

CIPA

Comies

Rlooriiagemin |
' =
Define Gauge Information and Gauge Components in the URL Gauge panel

In the URL Gauge panel, do the following:

1. Type in a name in the Gauge Name field.

2. Leave the Group Threshold value at ‘200'.

3. Set a Timespan of ‘60’ minutes by moving the slider tool to the right.

4. Leave the Gauge Method as ‘All'.
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5. In the Gauge Components accordion at the right side of the panel, go to the
Available Categories/Groups box and move the “Adware”, “Alcohol” and “Art”
selections into the Available Categories/Groups list box by selecting each cate-
gory and then clicking the Add button.

Reports | Gauges | Poiicy | administration | fetn | Logout Security Reporter ME‘E}
URL Gauge

Gauge Information

This screen allows you to
creste 3 new gauge or edit an
existing gauge.

Available Categories/Groups a Assigned CategoriesiGroups
Gauge Name:
A Adult Content Aleonol
Anaheim Ducks HHL Adware
Group Threshold: Animals/Pets Art
a0 = Bad Reputation Domains
Bandwidth
Timespan (minutes):
A . Bandwidth
1 10 20 30 a0 50 60
Ads
60 - Blocked Exception

Books & Literatureritings

Gauge Method: Hottlet

(@ Al ) Others () Pattern
Ve bt e Business/investments
() Search Engine Keyword
Chat
() URL Keyword (O URL

Chilg Pornography
() HTTPS Filtaring - High () Wildeard
() HTTPS Filtering - Medium () XStrike SR

Community/Organizations

Criminal Skills

| b User Membership J.

Save ] (LCancel

Define Gauge Information and Gauge Components

Step D: Select users to be monitored by the gauge

1. Click the User Membership accordion (located beneath the Gauge Components
accordion) to open it:

Reports | Gauges | Foicy | administration | fielp | Logout Security Reporter MBE)
URL Gauge

Gauge Information

Gau nents I
%ML-W e -

User Membership
Available User Groups Assigned User Groups

All 2 Custom (Custom)

Gauge Name:

Al (System)

Alist QABTestiDomain Admins (LDAF)

QAW2008\Group Level 2 (LDAF)
rs (LDAP)

AR 172.20.91.2 (Custom)

Group Threshold:

200 S

QAW2008\Domain

Timespan (minutes):
1 10 20 30 40 50 60

60 || @nsTestGroup Poiicy Creator Owners (LoAR)
Gauge Method: £ I
@ an @ omeen. (@) Patmen QABTestllS_WPG (LDAF)
)l it Ebvie e (@ABTestiRemote Deskiop Users (LDAF)
() URL Keyword (U URL
(_) HTTPS Filtering - High () Wildeard

(_) HTTPS Filtering - Medium (_) XStrike

QAUIZ00mChinese Bl LDAP)
QAUIZ008Idcagent services (LDAR)

QAW2008iDenied RODC Password Replication Group (LDAF)

GAW2008\Domain Admins (LDAF)

Save Cancel

Select users to be monitored by this gauge (sample URL Gauge panel)

2. From the Available User Groups box, choose the user groups whose activity will
be monitored by this gauge, and then click the Add button.
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Step E: Save gauge settings

Once you click Save, the Add/Edit Gauges panel redisplays and includes the
Gauge Name of the gauge you just added. Your new gauge is now ready to show
traffic.

NOTE: The initial gauge setup may take a few minutes. Once setup is complete, the
gauge will report data in real time.

How to create an automated gauge alert

This section will step you through the process of creating an automated threshold
per user, so you can be automatically notified via email and the violating user will
be automatically locked out once a threshold is exceeded.

Step A: Set up a new alert

1. Navigate to Policy > Alerts to display the panel by the same name:

Reports | Gauges | Policy | Administration Help Logout Security Reporter M )
Alerts
Bandwidth Gauges

Gauge Hame Group Threshold Timespan (minutes) Alerts

Select the Alerts option (sample Alerts panel with URL Gauges tab selected)

2. By default the URL Gauges tab displays, showing all gauges currently in use. To
create an alert for bandwidth gauges, click the Bandwidth Gauges tab:
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&

urty Reporter MBS

BECURITY

Alerts
| Gauge Hame ‘ Group Threshold Timespan (minutes) Alerts
@ e 19.53 MB 15
@ nHrP £4.00 MB 15
@ m 19.53 MB 15
@ 19,53 vE 15
@ s 19.53 MB 15

Select the Alerts option (sample Alerts panel with Bandwidth Gauges tab selected)

3. Choose the Gauge Name from the list in the left side of the panel, and then click
New Alert to display the next panel where you set parameters for the alert:

curity Reporter MBE®

SECURITY

Dandwidih Sayge; HITR

Alert

Fill out the fields below to define the alert. If
‘specifying an Email Alert Action, enter Email

Alert Hame:
User Threshald:

)

Alert Action:

|| Email | system Tray

|| Lockout
Severity: (Low requires categories/groups assignment]

Duration {minutes):

[!i I%J [ Uniimited

Add a New Alert (sample Bandwidth Gauges panel)

62

M86 SecuriTy EvaLuaTioN GUIDE



SECTION 2: REAL TIME REPORTS GET THE COMPLETE PICTURE

Step B: Specify Alert Information

Set parameters for the alert by making the following entries/selections in the Alert
Information sub-panel at the left side of the panel:

Reports | Gauges | Policy | Administration Help Lagout Security Reporter M |

Bandwidth Gauge: HTTP

ation
y Fill sut fields below to define the alert. If 7 Email Addresses
l\ specifying an Email Alert Action, enter Email
: )\ Addresses in the accordion to the right. Sl Adirase
AertRame Email Addresses
HTTP Bandwidth Gauge Alert
User Threshold:
5 il |~

Alert Action:

(/] Email || System Tray

b Low Lockaut Components J

ssve || Cancel |

Specify Alert Information (sample Bandwidth Gauges panel)

1. Type in a name in the Alert Name field.

2. Specify the User Threshold value. This numeric value is the number of times
each user will be allowed to visit categories monitored by the gauge before trig-
gering an alert.

3. Enable Alert Action checkboxes for “Email” and “Lockout.”

4. Select a Severity level (“Low”, “Medium”, or “High”). This section is only
enabled when the Lockout checkbox is selected.

» For a URL gauge, a “Low” selection will lock out the user by the categories
monitored by the specified URL gauge only. For a bandwidth gauge, a “Low”
selection will lock out the user by the protocols or ports monitored by the
specified bandwidth gauge.

» A “Medium” selection will lock out the user from Internet access altogether.

» A “High” selection will lock out the users from all network protocols, so they
cannot access the Internet, send e-mails, use instant messaging, or use P2P
or FTP.

NOTES: Time-based lockouts can be set for a range of 30 minutes, one hour to eight
hours, or unlimited.

System Tray will not be shown in this demo, but if this feature is enabled, the administrator
with an LDAP username, password and domain will see a system tray alert in the desktop
system tray when an alert has been triggered. This applies to Active Directory environ-
ments only.

M86 SecuriTy EvaLuaTioN GuIDE 63



SECTION 2: REAL TIME REPORTS GET THE COMPLETE PICTURE

64

Step C: Specify criteria in the right side of the panel

If the Email Addresses accordion is closed, click to open it. Type in an Email
Address and click the Add Email button. This is the address of the person who
will be notified when an alert is triggered. You can add multiple email addresses.

Reports | Gauges | Policy |Admini1lmtiun| Help ‘ Logout Security Reporter M; » |
URL Gauge: Ducks NHL

Alert Information

Fill out the fislds below to define the alert. If v Email Addresses
/4 speciiying an Email Alert Action, enter Email
= )\ Addresses in the sccordion to the right Email Address: ||

Alert llame: Email Addresses

User Threshold:
200 Ii'

Alert Action:

[ Email | System Tray

|| Lockout

Severity: (Low requires calegoriesigroups assignment)

Duratien (minutes)

| b Low Lockout Companents |

e (Lo

Specify email criteria (sample Bandwidth Gauges panel)

For a URL gauge alert, if a “Low” Lockout was specified, click the Low Lockout
Components accordion to open it. Go to the Available Categories/Groups list box
and move your selection(s) into the Assigned Categories/Groups list box by
selecting each category and then clicking the Add button.

Step D: Save the alert

Click Save to save your settings and to display the Alerts panel with the new alert
added.
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SECTION 3: SECURITY REPORTS

Security reporting features are available if using an SWG with your Security
Reporter.

Understand the most common and useful features

This section of the Evaluation Guide supplies the evaluator information on
employing basic tools in the Security Reporter to generate security reports using
log feeds of an SWG appliance running software versions 9.2.x and higher. You will
learn how the flexibility of the security report views lets you display different report
types without switching to another panel, or readily access the Report Wizard to
modify the current report view. As with productivity reports, security reports gener-
ated in the Security Reporter are easily customizable and can be saved, exported,
or scheduled to run on a regular basis.

Use security reports for a view of network activity

The four basic security report types—Blocked Viruses, Security Policy Violations,
Traffic Analysis, and Rule Transactions—are accessible via Reports > Security
Reports. Each report type provides a bar chart showing the top six security
offenders for the given report. This at-a-glance information lets you see which
areas of the network need to be safeguarded most:

Reports | Gauges | Policy | Administration Help Logout Security Reporter M

Security Report Wizard Rule Transactions
Report Type:  Blocked Viruses | Security Policy Violstions | Traffic Analysis | Rule Transactions

ctions | Display: Top 50 by Hit Count | Date: 07/07/2011 | Sort by: Hit Count, Descending

E I

QA Allow Trusted Sites + Bypass QA Block Access to Spyware Sites. QA block Alcohol Rule + Block +
QA Block Access to High-Risk Sit @A Block Known Viruses (WcAfee] QA Block Access 1o Blacklisted §

Rules Actions Policies IP Count User Count Hit Count v
62

QA Al

Bypass

QA Bloc High-Risk Site Categories Bloc

QA Block Ac Bloc

QA Block Ki

Bloc

QA black A

-
-
e fied e

&
k
Block
K
&

QA Medium Policy

QA Block Access to Blacklisted Sites Bloc

Report Settings | [l A | Esport Al Recoras | Go tn page: of 1 fotal pages
Rule Transactions security report

The four security report types contain the following information:

* Blocked Viruses - Includes details for each instance of each blocked virus
detected from end user Internet/network activity.

» Security Policy Violations - Provides information on each instance in which an
end user breached a security policy.
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» Traffic Analysis - Shows activity for end user access of objects utilizing an
excessive amount of network bandwidth.

* Rule Transactions - Includes each instance in which an end user triggered a
threshold in an SWG Security Policy.

For each report type, by default the top portion of the report view includes tabs for
all security Report Types. Beneath these tabs, a bar chart depicts the first six
records for the current report type.

@ TIPS: Clicking one of the Report Type tabs takes you to that report type.

Mousing over a bar in the chart displays the name of the record along with the total hit
count or bandwidth used in that record. The Rule Transactions report also includes
Actions and Policies information.

By default, the bottom porton of the report view contains a table that includes rows
of records. Columns of pertinent statistics display for each record.

How to modify the current report view

Page navigation tool

If more than one page is included in the report, the Go to page ‘x’ of ‘x’ total
pages field at the bottom right of the panel lets you specify the page number to
display in the report view, using the designated page range for reference.

Report view icons

Icons at the bottom left of the panel let you view either chart or record data in the
current report view:

« HL Click this icon to display only the top six bars in the chart:

Reports | Gauges | Policy | Adminisiration | Help Logout Security Reporter M

Security Repert Wizard Traffic Analysis
ReportType:  Blocked Viruses | Security Policy Violations || Traffic Analysis | Rule Transactions
Traffic Analysis | Display: Top 50 by Bandwidth | Date: 02/09/2011 | Sort by: Bandwidth, Descending

12 M8

1MB
03 MB
0.6 MB
name
: . . .‘

omMBe

Java Script ‘Web Page Adobe Flash Application Other CSSFile Active Textual Web Content
Report Setiings | [l ® Export All Records

Sample top six bar chart view
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[T°H
e |1 Click this icon to re-display the top six graphs and table of records (the
default view)

. Click this icon to display the table of records only:

Reports ‘ Gauges | Policy | Administration ‘ Help ‘ Logout Security Reporter MB{::(
Security Repert Wizard Traffic Analysis
ReportType: Blocked Viruses | Security Policy Violations || Traffic Analysis || Rule Transactions
Traffic Analysis | Display: Top 50 by Bandwidth | Date: 02/08/2011 | Sort by: Bandwidth, Descending
Traffic Analysis IP Count User Count Bandwidth v
Jawa Seript 2 3 110 WE
Web Page 2 ES 1.08 uB
Adobe Flash Application 1 1 s0410 kB
Other 2 4 261.30 kB
CS55 File 2 3 248 36 kB
Active Textual Uleb Content 2 ES 24885 kB
Scannable Active Content 2 Y 26888 kB
TextFile 2 E3 98.07 kB
Image 2 3 3110 kB
GIF Image 2 ES at10ke
Web Form 1 1 1484 kB
XML File 2 2 3.73 kB
Zip Jar Archive 1 2 237kB
Arshive 1 2 237 8
[LReport sexings_] ., 4 5] (_Exportai Resords_| | Expon seienieq | Bo 1o page S| of 1 totalpages

Sample records only view
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Create a customized security report

In addition to using one of the four basic security reports, you can generate a
customized security report containing content relevant to the area of your network

you wish to target.

How to generate a customized security report

There are two methods for creating a customized security report. One method is by
using the Report Settings’ Run feature, and the other method is by generating a
report view using the Report Wizard.

Step A: Choose a Run option

Option 1: Report Settings’ Run feature

In the security report view, mouse over Report Settings and choose Run to
display the Security Report Wizard panel for that report:

Reports | Gauges | Policy | Administration | Help ‘ Logout Security Repgner M
Security Report Wizard Traffic Analysis
Report Details Users

Report Time Span: Select a single user group fo view in this report. User groups can be created by accessing "Administration > User Groups™.

(_) Predefined Ranges User Groups

ADHNativeltmpGRP1 (LDAF)

(s) Date Range

From Date: To Date:

07/20/2011 07/20/2011
E E Facilities (Cusiom)

Top item Limit: HR (Custom)

T (Custom)

[] A | Ton: fs0 IEJ @
loadtestusers (Custom)
Marketing (Custom)
None {Custom)
Novell-eDirestory\apehadmn-Administratars (LDAP)
oryGroup? (LDAF)
ory|GRP_CA_USA_gegroup (LDAP)
ory\GRP_CA_USA_gegroup2 (LDAR)
ory\HIMS_GIN_ServerList! (LDAP)
0ry\QC_dyn_arp (LDAP)
Novell-eDirectory\QC_james-group (LDAF)
Novell-eDirectory'@C_james-group-dynamic (LDAF)
Hovell-eDirectory\QC_james-qegroupt (LDAF)
Hovell-eDiractorylGC_james-qegroup? (LDAF)
b By Spesific User |
BBy P |
Back LB [LFiers

Report Settings Run option

Option 2: Report Wizard’s Run feature

Navigate to Reports > Security Reports > Report Wizard to display the Security
Report Wizard panel where you will need to specify criteria to include in the report
you wish to generate:
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Reports | Gauges | Policy | Adminisiration | Help Logout Security Reporter M
Security Report Wizard Blocked Viruses
Report Details Users Email Settings

Report Hame: Email:

Report Type: Delivery Method: () To: () Bos: () Ce:

User Groups

| Blocked Viruses 2 10.130.0.0 {Cuscom) Email DM [Remove

Report Time Span: 10.130.0.1 {Cusiom)
® Predefined Ranges 10130.0.44 {Cusrom)
10.430.0.12 (Cusom)
| Today -
10.130.0.18 (Cusrom)
(_) Date Range
- 10.120.0.2 (Custom)

FomDate: ol 10.130.0.20 (Custom)

| Gl 10.430.0.4 {Gustom) Subject:

Top ftem Limit: 10.130.0.6 {Custom)

“ ABC-SunONE\4j.lane.edu_jlee-group (LDAF)

[ ] A Top: |50 e i Bady:
ABC-SunONE\Directory Administrators (LDAF)
{use if saving 2 report) ABGC-SunONE\groups_aj lane edu_jlee-group2 (LDAF)
Group By: ABC-SunONE\Groups_bialiblak {LDAF)
[ Blocked Viruses = ABC-SunONE\Groups_DynamicGroup (LDAF)

ABC-5unONE\Groups_james-group [LDAF) Output Type: | Email As Attachment | v |

|| Save report with URLs ABC-SUNONE\Groups_james-static-group (LDAP) Format: .| FOF

ABC-SunONE\Groups,
Top =
ABC-SunONE\QCGr:
ABC-Sun

ABC-SUNONEVQCGroun_Dvnamie Groi
| b By Specific User- |

\pByIP: |

£i| Schedule Settings Save Run

Security Report Wizard panel

Step B: Populate the Report Details sub-panel

1. In the Report Details sub-panel, if using the Report Wizard to create the report,
choose the Report Type from the pull-down menu (“Blocked Viruses”, “Security
Policy Violations”, “Traffic Analysis”, “Rule Transactions”); by default “Blocked
Viruses” displays.

2. Specify the Report Time Span by choosing one of two options:

* Predefined Ranges - If using the Report Wizard to create and run a new
report, this option is selected by default. If choosing this option, make a selec-
tion from the pull-down menu: “Today” (default), “Month to Date”, “Year to
Date”, “Yesterday”, “Month to Yesterday”, “Year to Yesterday”, “Last Week”,
“Last Weekend”, “Current Week”, “Last Month”.

» Date Range - If using the Report Settings’ Run feature, this option is selected
by default. If choosing this option, use the calendar icons to set the date
range.

3. Indicate the Top Item Limit to be included in the report; by default the Top
number of items specified in “Default Top ‘N’ Value” from Administration >
Default Report Settings is selected. To modify this selection, uncheck this box
and specify “All”.

NOTE: Choosing “All” records may take a long time for the report to generate, depending
on the number of records to be included.

4. If using the Report Wizard to create the report:

a. Specify the Group By selection from the available choices in the pull-down
menu.

b. By default, Save report with URLSs is de-selected. Click this checkbox to
select this option, and then specify the number of URLs to save:

e All URLSs - Check this checkbox to save all URLs
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» Top - Specify the number of top URLSs to be saved

Step C: Use accordions in the Users sub-panel

In the Users sub-panel, select one of the accordions and indicate criteria to include

in the report to be generated:

» By User Group - If selecting this option, choose the User Group for your report

query results.

» By Specific User - If selecting this option, enter the end username—using the
‘%’ wildcard to return multiple usernames—and then click Preview Users to

display query results in the list box below.

* By IP - If selecting this option, enter the end user IP address for filtering your
results—using the ‘%’ wildcard to return multiple IP addresses—and then click
Preview Users to display query results in the list box below.

For a Traffic Analysis or Rule Transactions report, you can narrow your search

result by including filters:

1. Click Filters at the bottom right of the panel to display the filter results panel:

Reports | Gauges | Policy | Administration |  Help | Logout

Security Report Wizard Rule Transac! tions

| B Poticias:

Security Reporter M =

w Rules:

|iufetons:

| b Content Type:

Back

Report Filters option

2. Choose a filter type from an available accordion (Policies, Rules, Action,
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Content Type) and indicate criteria to use in the filter:

* Select one or more records from the Available list box and click Add to

move the record(s) to the Assigned list box.

» Click the “Assign All” checkbox to select all records and grey-out the

panel.
3. Click Back to return to the Security Report Wizard panel.
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Step D: Run the report

Click Run to generate the security report view:

Reports | Gauges | Policy

Security Report Wizard

QA Allows Trusted Sites
QA Block Access to Blacklisted Sites
QA Block Known Viruses (McAfee}

QA Allow Access to Uhite Listed Sites

QA Block I Tunneling

[_Report setings | Jly.

@A Block Access to High-Risk Sit.
QA Block Access to Spyware Sites...

| Administration | Help | Logout

Rule Transactions

ReportType:  Blocked Viruses | Security Policy Violations | Traffic Analysis

Rule Transactions | Display: Top 50 by Hit Count | Date: 02/04/2011

Security Reporter

Sort by: Hit Count, Descending

Rule Transactions

M

-’ | I T —

QA block Alcohol Rule + Black +

Rules Actions
QA Block Aceess to High-Risk Site Categories Block
QA Block Access to Spyware Sites Block
QA black Alcohol Rule Block

Bypass scanning
Block
Block
Allow content and scan containers

Block

QA Allow Trusted Sites + Bypass ...

Policies

QA Medium Policy
QA WMedium Policy
QA Medium Policy
QA Medium Policy
QA WMedium Policy
QA WMedium Policy
QA Medium Policy

QA Medium Policy

[LEsportan Recoras._|

IP Count

QA Block Access to Blacklisted §

QA Block Known Viruses {McAfee}

User Count

Go to page:

Hit Count

k|

oo

1

v

total pages

Generated Security Report view

The report can now be exported by selecting one of the two export options.
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Capture the security report in PDF format

How to export current report view data

From the current report view, you can select specified records or all records to be
exported in the PDF format, and then download or email the PDF on demand.

Step A: Specify records to include in the report

In the current report view, select the records to be included in the report by either
clicking Export All Records, or choosing specific records from the table and then
clicking Export Selected. Clicking either button opens the Export Report pop-up
window:

Group By: | Rules v || Subject:

Top ltem Limit: || Al | Top: |50 \i‘ 5 Body:

Format: .| POF
|| Export report with URLs

Top:

»| Email:
Delivery Method: (@) To: () Boe Ce:

Email DiM | Remove

Output Type: | Email As Attachment - |

| _Email | | Download | | Close |

Export Report pop-up window, Export All Records option

Step B: Specify Group By and URL limitation criteria

1. In the Export Report pop-up window, specify the Group By selection from the
available choices in the pull-down menu.

2. At Top Item Limit:

« If the Export All Records option was selected, the Top number of items spec-
ified in the “Default Top ‘N’ Value” field from Administration > Default Report
Settings displays and can be modified by either editing the displayed value or
choosing “All”.

NOTE: “All” records may take a long time for the report to generate, depending on the
number of records to be included.

« If the Export Selected option was selected, “All” is greyed-out. Specify the
Top number of items to be included in the exported report.
3. By default, Export report with URLSs is de-selected. Click this checkbox to
select this option, and then specify the number of URLS to export:
» All URLSs - Check this checkbox to export all URLs
» Top - Specify the number of top URLS to be exported
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Step C: Download or email the report

Now you must choose whether to download or email the report.

Option 1: Download the report

To download the report in PDF format, click Download. The PDF file can be
printed, saved, or emailed.

Option 2: Email the report

To email the report:

1.

Enter at least one Email address and then click Add to include the email
address in the list box below.

Specify the Delivery Method for the email address: “To” (default), “Bcc”, or
“Cc”.

Enter the Subject for the email message.
If you wish, enter text to be included in the Body of the message.

Specify the Output Type for the email: “Email As Attachment” or “Email As
Link”.

. Click Email Report to send the email to the specified recipient(s).
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Security Report format

The generated Security Report PDF file includes the following information:

Security Reporter Feb 04, 2011 - Feb 04, 2011 M

Rule Transactions
Top 50 Rule ions by Hit Count Di

Hit Count
-
BN W R WO N R WO
cococccco oSS

QA Block QA Block QA block QA Allow QA Block QA Block
Access to Access to Alcohol Trusted Access to Known Viruses
High-Risk Si... Spywa... Rule... Sites... Blacklist... (McAfee)...
Rule Transactions
Rules Actions Policies IP Count User Count Hit Count
QA Block Access to High-Risk Site Block QA Medium Policy 1 1 110
Categories
QA Block Access o Spyware Sites Block QA Medium Policy 1 1 34
QA block Alcohol Rule Block QA Medium Policy 1 1 22
QA Allow Trusted Sites Bypass scanning QA Medium Policy 1 1 15
QA Block Access to Blacklisted Sites Block QA Medium Policy 1 1 8
QA Block Known Viruses (McAfee) Block QA Medium Policy 1 1 6

2/04/2011 4:14:42 PM Generated By administrator Page 1 of 2

Sample PDF for Rule Transaction Security Report, page 1

The header of the generated report includes the date range, report type, report
criteria, and report description.

The footer of the report includes the date and time the report was generated (M/D/
YYYY, HH:MM:SS AM/PM), administrator login ID (Generated by), and Page
number and page range.

The body of a basic report includes a bar chart showing the top six graphs with
count indicators, and the report name. Following the bar chart is a list of records,
with the corresponding Item Count for each record. For Rule Transaction reports,
Actions and Policies column data precede Item Count column data.

For Bandwidth or Hit Count detail report views, the body of the report includes
columns set up to be visible. These columns might include Date (M/DD/YYYY
H:MM:SS AM/PM format), IP, User name path, Site, bandwidth Size (e.g. kB), and
URL, as in the sample below:
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Reporter Mar 08, 2011 - Mar 08, 2011

Traffic Analysis
Top 1000 Traffic Analysis, Group by Mone, Sort by Date, Ascending
This report has been generated for Web Page

MEE

Dater [ Usor Site Size
HOBZ011 34709 AM 192.168,10.118 ChaulChau Chau skypee. com 029 kB
sy ComAANS, 0,0, 152 1528unasN:
A0B2011 T:4T08 AM 19216810116 ‘Chau'Chau Chau skype.com 025 kB
hiipfskype. Comnais,0.0.152. D015ZEunash
HORZ011 9:42:40 AM 192 168,200,246 ancdmin bing com 20.75 kB
Hip g
HOB2011 9:42:46 AM 192.168.200.246 admin bing.com 216 kB
itpciving enmiaTine=T_00_0_BA4EASLalds]
AORZ011 9:58:15 AM 192.168.10.118 ChaulChau Chrome: usatoday com 11947 kB
hip usaloday. com
H0B2011 9:58:19 AM 192.168.10.116 Chau\Chau Chronme adsonar com 351kB
p Qi ATES SR P =4 26 AP T ITTTA e 3ARA TR TSR Lr R USFOCTY, COmIRYs SAStRichAds s 1
HOB2011 95828 AM 192.168,10.116 ‘Chau\Chau Chrome facebook com 5.32 kB
ak fcdn. ooy pher ¥
AOB011 95844 AM 192 16810 116 ChaulChau Chrome: atdmt. com 111 kB
hitpatdmt comiachon/'adoapn_ AppNexusDemaAcionTag 1
0B2011 8:58:54 AM 192 16810116 ChaulChau Chrome usatoday. com 48.91 kB
00-0-ta8ban0g_ST_N hm
WOR011 95904 AM 192 168,10 116 ChauChau Chrome: ulbram com 1.01 kB
himiandom=0.
0B2011 5:59:06 AM 192 16810116 ‘Chau\Chau Chrome facebook com 383 kB
oo pheerel=hiip
HOR011 95906 AM 192.168,10.116 ChaulChau Chrome twitter.com 433 k8
Ip itwitler f_bustton himi_: 5. Rands have taken oul 500 Talthan keaders -
USATODAY. Lurk 1-03-08-1a0ban08_ST_N himavia=USATODAY
0B2011 11:39:37 AM Generated By:  administrator Page 10f9

Sample PDF for detail Security Report

At the end of the report, the Total Items display for all records.
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Save the security report you generated

How to save a security report

A security report can be saved only by using the “Report Settings” Save option.

Step A: Select Report Settings, Save option

In the current security report view, mouse over Report Settings and choose Save
to display the Security Report Wizard panel for that report:

Reports | Gauges | Policy | Administration Help Logout Security Reporter M
Security Report Wizard Rule Transactions
Report Details Users Email Settings

Report Name: et

Select a single user group fo view in this report. User groups can be.

created by accessing "Administration > User Groups"

Delivery Method: (@) To: () Bec: () Ce:
Report Time Span: User Groups
Email DM Remove
\_) Predefined Ranges 19.330.0.0/fCuztom)
10.130.0.1 (Custom)
10.120.0.11 {Custom)
(&) tara Rance 10.130.0.12 {Cuscom)
From Date: To Date: 10.130.0.19 (Custom)
o7i07r2011 |[F | 07a07r2011 |8 10.130.0.2 (Custom)
10.1230.0.20 {Custom)
Top ltem Limit:
10.130.0.4 (Custom) Subject:

Al | Top: |50 =
L 2 ¢ 10.130.0.6 (Custom)

sa ir S = vepory ABC-SunONE] lane.edu_jlee-group (LDAF)

Group By: ABC-SunONE\Directory Administrators (LDAF)
ABC-SunONE\groups_dj lane edu_jlee-group2 (LDAF)
| Rutes v

ABC-SunONEVGroups_bialibi,ak (LDAP)

W e ABC-SunONE\Groups_DynamicGroup (LDAP)
ABC-SunONE\Groups. Output Type: | Email As Attachment v |
Top: e

ABC-SunONE\Groups, Format  [i| PDF

ABC-SUnONE\Groups,
ABC-SunONEGCGroup_Dy; oup1 (LDAF)
ABC-SunONEVQCGroup_Dy oup2 [LDAF)
ABC-5unONE\@CGroun Dvnamic Grouns LDAP)
| b By Specific User: |
By IP: |

Back ( save | (Lriners
Report Settings Save option

Step B: Specify criteria in the Report Details sub-panel

1. In the Report Details sub-panel, type in the Report Name.
2. Specify the Report Time Span by choosing one of two options:

» Predefined Ranges - If choosing this option, make a selection from the pull-
down menu: “Today” (default), “Month to Date”, “Year to Date”, “Yesterday”,
“Month to Yesterday”, “Year to Yesterday”, “Last Week”, “Last Weekend”,
“Current Week”, “Last Month”.

» Date Range - This option is selected by default. If choosing this option, use
the calendar icons to set the date range.

3. Indicate the Top Item Limit to be included in the report; by default the Top
number of items specified in “Default Top ‘N’ Value” from Administration >
Default Report Settings is selected. To modify this selection, uncheck this box
and specify “All”.

NOTE: Choosing “All” records may take a long time for the report to generate, depending
on the number of records to be included.
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4. Specify the Group By selection from the available choices in the pull-down
menu.

5. By default, Save report with URLSs is de-selected. Click this checkbox to select
this option, and then specify the number of URLSs to save:

» All URLSs - Check this checkbox to save all URLs
» Top - Specify the number of top URLSs to be saved

Step C: Select the users or group in the Users sub-panel

In the Users sub-panel, select one of the accordions and indicate criteria to include
in the report to be generated:

» By User Group - If selecting this option, choose the User Group for your report
guery results.

» By Specific User - If selecting this option, enter the end username—using the
‘%’ wildcard to return multiple usernames—and then click Preview Users to
display query results in the list box below.

* By IP - If selecting this option, enter the end user IP address for filtering your
results—using the ‘%’ wildcard to return multiple IP addresses—and then click
Preview Users to display query results in the list box below.

For a Traffic Analysis or Rule Transactions report, you can narrow your search
result by including filters:

1. Click Filters at the bottom right of the panel to display the filter results panel.

2. Choose a filter type from an available accordion (Policies, Rules, Action,
Content Type) and indicate criteria to use in the filter:

« Select one or more records from the Available list box and click Add to
move the record(s) to the Assigned list box.

» Click the “Assign All” checkbox to select all records and grey-out the
panel.

3. Click Back to return to the Security Report Wizard panel.
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Step D: Populate the Email Settings sub-panel

1. Inthe Email Settings sub-panel, enter at least one Email address and then click
Add to include the email address in the list box below.

2. Specify the Delivery Method for the email address: “To” (default), “Bcc”, or
“CC”.

3. Type in the Subject for the email message.

4. If you wish, enter text to be included in the Body of the message.

5. Specify the Output Type for the email: “Email As Attachment” or “Email As
Link”.

Step E: Save the report

Click Save at the bottom of the Security Report Wizard panel to save your settings
and to add the report to the Saved Reports panel.
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Two methods for scheduling security reports

A security report can be scheduled to run using either the Report Settings
Schedule method or the Security Report Wizard. Using the former method saves
several steps, since the panel will be pre-populated with data from the current
report view.

How to use Wizard panels for scheduling reports

Step A: Choose the method for scheduling the report

Method 1: Use the current report view

In the current security report view, mouse over Report Settings and choose Save
to display the Security Report Wizard panel for that report:

Reports | Gauges | Policy | Administration Help ‘ Logout Security Reporter M -
Security Report Wizard Rule Transactions
Report Details Users Email Settings
Report Name: Email:
Dalivery Mathod: () To: () Bee: () Ce:
Repart Time Spam User Groups
Email DM |[Remove
(_) Predefined Ranges AUH300Y (Cotom)
10.130.0.1 (Custom)
10.130.0.11 {Cusom)
O L 10.130.0.12 (Custom)
From Date: To Date: 10.130.0.18 {Custom)
07/07/2011 [ | 07/0752011 | 10.130.0.2 (Custom)
10.130.0.20 {Cusrom)
Top item Limit:
10.120.0.4 (Custom) Subject:

Al | Top: 50 e
= % I=]* 10.130.0.6 (Custom)
= ABC-SunONEWS] lane.edu_jlee-group (LDAP)
{use i saving a report} Body:
i ABC-S5unONEWirectory Administrators (LDAP)

_4j.lane.edu_jl 2 (LDAF)

| Rutes v |
ABC-5unONEYGroups_bialb,ak (LDAF)

ABC-SUnONEVGroups_Dys

|| save report with URLs
ABC-SunONEVG

Output Type: | Email As Attachment | v
Top: Sttt |
ABC-SunONE\Groups.

Format || PDF
ABC-5unONE\Groups,

ABC-sun
ABC-Sun
ABC-SunONEVQCGroun Dvnamic Groun5 (LDAP)

Sy ipeaictizss |
\B.BYIP: |

Back 7] Schedule Seftings | Save | | Filters

Report Settings Save option
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Method 2: Create a report using the Wizard

Navigate to Reports > Security Reports > Report Wizard to open the Security
Report Wizard panel:

Reports | Gauges | Policy | Administration | Help Logout Security Repor{er M
Security Repert Wizard Blocked Viruses
Report Details Users Email Settings

Report Name: Email:

user group to view in this report. User groups can

ssing "Administration > User Groups™.

Report Type: Delivery Mathod: () To: () Bee: () Ce:

User Groups

| Blocked Viruses - 10.130.0.0 {Custom) Email DM [Remove

Report Time Span: 10.120.0.1 (Gustom)
8 Predefined Ranges 10.130.0.41 (Custom)
10.120.0.12 {Custom)
| Today x|
S 10.130.0.18 (Custom)
) Date Range
= 10.130.0.2 (Custom)
From Dote: Hokate; 40.130.0.20 (Custom)
G| | 10.120.0.4 {Custom) Subject:

Top em Limit: 10.130.0.6 (Custom)
= ABC-SUnONEM4] Iane edu_jlee-group (LDAF)

] Al Top: |50 e Body:
ABC-SunONE\Directory Administrators [LDAP)

{use if saving a report} ABC-SunCNE\groups_4j. 1_jlee-group2 (LDAF)
Group By: ABC-5unONE\Groups_blalibl ak (LDAF)
[ Blooked Viruses = ABC-SUNONE Groups_DynamicGroup (LDAF)
=
ABC-SunONE\Groups_james-group (LDAP) OutputType: | Email As Attachment | v |
|| Save report with URLs ABC-SunONE'Groups_james-static-group (LDAP) Format: | POF

Top ABC-S5unONE\Groups_QA Managers (LDAF)
ABC-SUnONEYRCGroup_Dynamic Group1 (LDAF)
ABC-SunONE\GCGroup_Dynamic Group3 (LDAF)
ABC-SunONE/QCGroun Dvnamic Grouo LDAP]

| b By Specific User- |

= |

%] Schedule Seftings Save Run

Security Report Wizard panel

Step B: Fill in the Report Details sub-panel

In the Report Details sub-panel:
1. Type in the Report Name.

2. If using the Report Wizard to generate and schedule a report, choose the
Report Type from the pull-down menu (“Blocked Viruses”, “Security Policy
Violations”, “Traffic Analysis”, “Rule Transactions”); by default “Blocked Viruses”
displays.

3. Specify the Report Time Span by choosing one of two options:

» Predefined Ranges - If using the Report Wizard to generate and save a
report, this option is selected by default. If choosing this option, make a selec-
tion from the pull-down menu: “Today” (default), “Month to Date”, “Year to
Date”, “Yesterday”, “Month to Yesterday”, “Year to Yesterday”, “Last Week”,
“Last Weekend”, “Current Week”, “Last Month”.

» Date Range - If using the Report Settings Schedule feature, this option is
selected by default. If choosing this option, use the calendar icons to set the
date range.

4. Indicate the Top Item Limit to be included in the report; by default the Top
number of items specified in “Default Top ‘N’ Value” from Administration >
Default Report Settings is selected. To modify this selection, uncheck this box
and specify “All”.

NOTE: Choosing “All” records may take a long time for the report to generate, depending
on the number of records to be included.
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5. Specify the Group By selection from the available choices in the pull-down
menu.

6. By default, Save report with URLSs is de-selected. Click this checkbox to select
this option, and then specify the number of URLSs to save:

» All URLSs - Check this checkbox to save all URLs
» Top - Specify the number of top URLSs to be saved

Step C: Include the users or group in the Users sub-panel

In the Users sub-panel, select one of the accordions and indicate criteria to include
in the report to be generated:

» By User Group - If selecting this option, choose the User Group for your report
guery results.

» By Specific User - If selecting this option, enter the end username—using the
‘%’ wildcard to return multiple usernames—and then click Preview Users to
display query results in the list box below.

* By IP - If selecting this option, enter the end user IP address for filtering your
results—using the ‘%’ wildcard to return multiple IP addresses—and then click
Preview Users to display query results in the list box below.

For a Traffic Analysis or Rule Transactions report, you can narrow your search
result by including filters:
1. Click Filters at the bottom right of the panel to display the filter results panel.

2. Choose a filter type from an available accordion (Policies, Rules, Action,
Content Type) and indicate criteria to use in the filter:

« Select one or more records from the Available list box and click Add to
move the record(s) to the Assigned list box.

» Click the “Assign All” checkbox to select all records and grey-out the
panel.

3. Click Back to return to the Security Report Wizard panel.

Step D: Complete information in the Email Settings sub-panel

In the Email Settings sub-panel:

1. Enter at least one Email address and then click Add to include the email
address in the list box below.

2. Specify the Delivery Method for the email address: “To” (default), “Bcc”, or
“Cc.

3. Type in the Subject for the email message.
4. If you wish, enter text to be included in the Body of the message.

5. Specify the Output Type for the email: “E-Mail As Attachment” or “E-Mail As
Link”.
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Step E: Set the schedule for running the report

1. Go to the lower right corner of the panel and click Schedule Settings to open
the Schedule Settings pop-up window:

v
Schedule Settings x |

’/‘\ NOTE: If you would like your scheduled
\: event to run today, be sure to specify a
i (= [& | future Start Time for today.

Name
]
When to Run: | Daily v

Start Time
g = : o | am | ¥
= - [~ = ')

Close

Schedule Settings pop-up window

2. Enter a Name for the report run event you are scheduling.

3. Select the frequency When to Run from the pull-down menu (Daily, Weekly, or
Monthly).

If Weekly, specify the Day of the Week from the pull-down menu (Sunday -
Saturday).

If Monthly, specify the Day of the Month from the pull-down menu (1 - 31).

4. Select the Start Time for the report: 1 - 12 for the hour,
0 - 59 for the minutes, and AM or PM.

5. Click Close to save your settings and close the pop-up window.

Step F: Save the report

Click Save at the bottom of the Security Report Wizard panel to save your settings
and to add the report to the schedule to be run.
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How to access and view the Report Schedule panel

The Report Schedule panel is used for maintaining a schedule for generating a
customized productivity or security report.

Navigate to Reports > Report Schedule to display the Report Schedule panel:

Reports | Gauges | Policy | Administration | Help | Logout Security Reporter M )
Report Schedule

Click on a schedule to edit.

Hame interval | LastRun Next Run Custom Report Name Start Time
Blocked Viruses Uieskly Report  eskiy 101082010 2:05:00 Ph 1011512010 2:05:00 P Blocked Viruses Uisskly Report 2:05 P11
Instant Message Suruv\amREDﬂ 10/1212010 9:00:00 AN Drill Down Summary Category Sites '9:00 AM
Daily Summary Sites Report Daily 10/12/2010 8:30:00 AM Sites Report 8:30 AM

Add Event Delete Refresh

Report Schedule panel

In the Report Schedule panel, reports scheduled to be run display as rows of

records. The following information is included for each record: Name assigned to
the scheduled report, Interval when the report is scheduled to run, date and time of
the Last Run, date and time of the Next Run, Custom Report Name, and Start Time

for the report to run.

NOTE: Records in this panel may include summary productivity reports, detail productivity
reports, and security reports.
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View Details for a Scheduled Report Run Event

To view additional information on a scheduled report run event, select the record
from the list to display the report schedule details sub-panel to the right of the table

of report records:

Reports | Gauges | Policy | Administration |  Help Logout

Report Schedule
Click on a schedule to edit,

Hame Interval Last Run NextRun Custom Report Hame
Blocked Viruses V. Weekly 10/08/2010 2:05:01 10/15:2010 2:05:01 Blocked Viruses Weekly Report
Instant Message £ Weekly 10/12¢2010 9:00:01 Drill Down Summary Category Sites

Wieekly Summary  Veekly 101242010 8:30:01  Sites Report

Add Event [ Refresh

start Time
2:05 P
9:00 AW

8:30 AW

Security Reporter M )

/"/‘\ NOTE: If you would like your scheduled event
— 10 run today, be sure to specify a future Start
4= & ||| vime ror taay.

Hame

Report to Run:

Sites Report

When ta Run: | Daily -

Start Time

s i::jn

@AM v

Cancel

View report schedule details

The following information displays in this sub-panel: Name assigned to the sched-
uled event; selected Report to Run; interval When to Run the report; Day of the
Week the report will run if the report is a daily report, or Day of the Month the report
will run if the report is a monthly report, and Start Time to run.

TIP: To remove a report from the Report to Run list, go to the Saved Reports panel and

delete that report from the list.
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